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Epicor ERP 10 Interface and System Navigation  
 

The Navigation course focuses on the Epicor application user interface. Each section describes 
different areas of the application. Beginning with the system level, and followed by the 
module and program levels, this course explores the different navigational features available 
at each level and area of application. 

 

User Interface 
 

The Epicor application has three levels of interface navigation: system (also known as the 
Main menu), module, and program. Most of the navigation features exist on the program 
level; therefore, the course mainly focuses on the program level. 
 

Log On 
User must log in into the Epicor application to access the Main menu or any program(s) in the 
application. 
 
Procedure: For EWA 
1. Open Internet Explorer in your PC 
2. Enter the server IP address in the browser 
3. In the User Name field: enter user ID. 
4. In Password field: enter the password. 
5. Click Right Arrow for OK / Enter. 
 
The Epicor Login Display 
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Home Display in EWA Version 

 

In this mode the home is the Main Menu Display, where other useful tools can be accessed 
from top bar and from the right side shortcuts toolbars 
 
 

Main Menu Overview 
The user interface at the highest level is called the Main menu. At this level user have access 
to all modules and program in Epicor. The Main menu is home base within the application. 
This window displays first when user launch the application in EWA. Through this interface 
user will be able to access any program and function with regards to user matrix. 
 

a) The Main menu displays all the modules and major functions that are 
contained within the application. Each module group, such as Financial 
Management, contains a series of related modules. 
 

b) In-turn, each module, such as Accounts Receivable, contains the Setup, 
General Operations, and Reports programs.  

 
See the below Illustration 

 
 
Main Menu Display – Zoom View 
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1. List View and Zoom View mode displays for Main Menu Easy Accessibility 

2. Main Menu Display in Zoom View where the right side shows the programs 
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Main Menu Display – List View 

 
 

User can click on a triangle icon like this  on left side of each folder module to see the sub-

folders/programs listed beneath it, or user can click the folder itself to see its subprograms 

listed in the right pane. Click a folder in the right pane to see its contents; click a program 

name in the right pane to start that program. 

Top Bar 
 
The Top Bar is located at the top of the screen. This bar has different view depending of the 
version of Epicor in use, below is the illustration of the bar: - 

 

Top Bar in EWA 

 
In EWA the bar contains important links as shortcut in a group of four items i.e. File, Options, 
Help and Epicor on the Web link. As can seen in the picture above each group has sub-items 
for navigation and personalization. 
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Module-Level Overview 
 
The user interface at the module level is a segment of the main interface, and it provides an 
explorer-type view of all application’s categories and modules. The Tree or Zoom view 
structure for each module group can be expanded to display the modules included in each 
group. Each individual module can then be expanded to display the two or more main folders 
that made up the module, and each of those folders in turn can be opened to display a list of 
its available programs. 

 

Program-Level Overview 

 
The user interface at the program level contains all the functionality needed to enter and 
manipulate data. 
Use the options on the Menu bar, Standard toolbar, and Navigation toolbar to create new 
records, modify existing records, and access additional program capabilities. 
Tip: User can open multiple instances of each program. The same program can then display 
in multiple windows, so user can review different records at the same time. 
 

Program Interface 

 
Following is an illustration of a typical program interface. 
 

Menu Bar 

 
The Menu bar for a program displays the standard menus, such as the File, Edit, Tools, Action 
and Help menus. Each menu contains a list of related options. 
 

 
a) File Menu- This menu allows user to save and delete records. The File menu also contains 

the Exit option, which allows user to leave the program 
b) Edit Menu- This menu allows user to manipulate items on the current record. User can 

cut, copy, and paste text from one field to another. 
c) Tools Menu- This menu allows user to customize or personalize the current program. 
d) Actions Menu- This menu displays options specific to the current program and in some 

programs the menu might not be active. 
e) Help Menu- This menu allows user to launch the Application Help or to run a tutorial for 

the open program. 
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Standard Toolbar 

 
The Standard toolbar control set in a program contains the buttons needed for manipulating 
data on the current record. These controls allow user to create, save, and delete records. They 
also give user editing controls, allowing user to cut, copy, and paste text into different fields. 
The following exhibit describes each control available on the Standard toolbar. 
 

Control Level Detail 

 

Icon Description 

 

New - Creates a new record. If available, the drop-down arrow associated with 
the New button provides a list of the types of records user can create with the 
program user are running. If the List sheet is selected, clicking New typically 
adds a blank line to the list to enter a new record. 

 

Save - Saves a new record or saves the changes made to an existing record. 

 

Delete - Deletes a record or deletes part of a record, such as a line on a sales 
order. 
 

 

Change Log - Select this button to display the Change Log. All the changes 
made to the current record display within this log. 

 

Memo - Click this button to view any memos written for the current record. 
If a memo or attachment is linked to a record, a star appears on the button 
icon. 

 

Call Log - Click this button to review, add, edit, or delete Call Log records 

 

Attachments - Allows external documents to be attached to records in the 
application. Attachments are only available when user have the Document 
Management module licensed. 

 

Refresh - Refreshes data on the current sheet. 

 

Clear - Clears any data entered into the program. 
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Icon Description 

 

Print - Click this button to print the current record. 

 

Cut - Click this button to cut the current selection (usually text) and move it to 
the Clipboard to later paste it elsewhere. This is a standard Windows 
convention and can also be achieved by pressing Ctrl + X on your keyboard. 

 

Copy - Click this button to copy the current selection (usually text) and move 
it to the Clipboard to later paste it elsewhere. This is a standard Windows 
convention and can also be achieved by pressing Ctrl + C on your keyboard. 

 

Paste - Click this button to paste the contents of the Clipboard to where your 
cursor currently sits. This is a standard Windows convention and can also be 
achieved by pressing Ctrl + V on your keyboard. 

 

Undo - Click this button to remove the last action you performed within the  
program i.e. to have effect of inputs before the last action 

 

Navigation Toolbar 

 
The Navigation toolbar allows user to find specific records created by the current program. 
Use the Search control to find a record or records in the open program. 
 

Icon Description 

 
 

 

Search - Click this button to launch the main search window for the current program. Use 
this window to find and select all the records you want to review within the active 
program. In most search windows, you can select multiple records at the same time. The 
search functionality is explored later in this chapter. 

 

First Record - Click this button to display the first record. 

 

Previous Record - Click this button to display the record numerically just ahead of the 
current record. 

 
Current Record - This field displays the current record displayed within the program. To see a 
list       of all the records currently loaded into the program, click the Down Arrow button. 
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Next Record - Click this button to display the record numerically just after the current record. 

 

Last Record - Click this button to display the final   record. 

 
Use the navigation tools to scroll through the records user created since entering the program 
and the records user pulled in from the corresponding Search window. 

 

 
 

Currency Toolbar 

Use the Currency toolbar to quickly convert the transaction amounts displayed within the 
current record to a different currency. When you select a different currency, all the amounts 
within the current record convert to reflect the current exchange rate and conversion rule 
assigned the source (original) and target (selected) currency pair. 
 
Your company can have several currencies available. The currency functionality is explored in 
more detail within the Multi-Currency Management chapter in the EPICOR ERP 
Implementation Guide. 
 
To use the Currency toolbar: 

 Click the Down Arrow on the    toolbar. 

 

 The list displays the currencies available within the company. Select the currency 
you need. 

 

The Currency toolbar now displays the selected currency; all the amounts within the current 
record update to show the recalculated amounts 
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Status Bar 

The Status Bar is found at the bottom of each program window. It displays information about 
the current session such as current user, date, time, current company, and so on. You can 
choose the information that displays on the Status Bar. To do this, click the Tools > Options 
and select the information you want to display on the Global Options > Status Bar sheet. 

 

 

 

Tree View 

The Tree View is a tool you use to navigate through the items that make up a selected, 
complex record. 

The current record automatically displays within the Tree View. When you expand the nodes 
on the tree by clicking the + icons, you can quickly locate (or drill down) to a specific item 
within a record. 

In this example, you selected a release from order 5253. When you select this node on the 
Tree View, the Release sheet automatically displays with the selected order release 
information. 

 

 

Sheets 

 

A sheet is a layer of a program's interface that contains related functionality. It is the main 
input and display area for a program. Most programs have a minimum of two sheets, which 
are the Detail and the List sheets. 
 
Sheets can be torn off and placed anywhere on the desktop. To reset all the sheets back to 
their default positions, use the Restore Default Settings option. 
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There are several navigation features within a sheet which includes buttons, grids, tabs, 
context menus, drop-down menu, status indicators, etc. The following are the most useful 
features. 

Buttons 

 
Sheets typically contain buttons, which provide access to record search programs. Other 
buttons provide access to additional functionalities related to the program. 

Grids 

 
Grids display information through a series of columns and rows. Each column displays a 
category of information, while each row displays data from individual records. Grids do not 
display all data entry fields, as they contain only those fields that require data entry. 

Copy and Paste Grids 

 
Grid Copy- The Grid Copy function is designed as a way to copy the visual fields from grids so 
they can be pasted into a spreadsheet application such as Microsoft Excel®. The grid Paste 
Update and Paste Insert functions are designed as ways to update and add to the visual and 
editable fields in a grid using data copied from a spreadsheet application. 
 
Executing a Grid Copy- When executing a Grid Copy, data is pulled from the visual columns in 
the order they appear on the grid (left to right). The same occurs with a Paste.  

 
Grid Paste Update- With a Grid Paste Update, visible and editable fields are updated one at 
a time from left to right and from top to bottom. If an error occurs, the paste process is 
terminated, even if all the data has not been pasted into the grid.  
 
Grid Paste Insert- With a Grid Paste Insert, visible and editable fields are updated the same 
way as with a Paste Update with the exception that fields in a new row are being updated. 
Status Indicators 

 

Tabs 

 
Tab may contain multiple elements and sheets; whereby tab buttons helps to navigate 
between tabs and sheets in order to explore, manage and input additional data. 

Context Menus 
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Context menus are available throughout the application by right-clicking in a field, text box, 
or grid. These menus offer options for accessing additional programs, such as Tracker and 
Search programs, and also offer text editing capabilities.  

Personalization 

 

Personalization allows user to have a different feel and touch on the Epicor application by 
adjusting the views, options, and toolbars to suit at best user’s business needs.  
Use the Epicor Personalization Tools to modify each program interface. User can personalize 
any program in order to refine the interface to match the tasks performed every day. 
 
Note: Personalization is saved with User ID and do not affect other users within the 
application. 
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System Setup 
 

The System Setup module is important for setting up system-wide information, such as 
configurations, processes, maintenance, and other system tasks. There are two maintenance 
programs that contribute to the make-up of a user account, Company Configuration and 
Security Group Maintenance. 

 

Company Configuration 
 

Contains the setup programs used to configure companies within the application. When user 
install the Epicor application, one company record is automatically created by default. User 
can then use this program to define how the company interacts with the various modules in 
which user have licensed with. 
 
Menu Path 
Navigate to this program from the Main Menu: 
System Setup → Company/Site Maintenance→Company Configuration 
 

→ 
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Security Maintenance 

Security Group Maintenance 

 
Use Security Group Maintenance to establish groups to which users can be assigned for 
security purposes. Assign a user to a security group in User Account Maintenance, and assign 
security groups in Menu Maintenance. 
 

Epicor recommends you assign all users to security groups. You then simplify your security 
setup, as you do not need to assign security to individual users. This approach also ensures 
you implement security through an organized and clearly defined method. 
 

Menu Path 

Navigate to this program from the Main Menu 
System Setups → Security Maintenance → 
Security Group Maintenance 

Objective/Comment To define Security Group(s) 

Requirement The user must have access to Security Group maintenance 

Navigation Path System Setups → Security Maintenance → Security Group 
Maintenance 

Responsibility with As per User Security Matrix 

 

1.  Click New icon in the form to activate the form or click File then 
New 

2.  Type short form of the group in the Group ID. 

3.  Write the group description in the description field. 

4.  Owning Company field will by default display the 000 code for the 
company. 

5.  Save and exit the form 
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NB: Groups are useful because they can categorize employees by role or 
department. Security groups are optional. 

 

User Account Maintenance 

 
Use User Account Security Maintenance form to enter basic information, security access, 
and application privileges for all users. Anyone who accesses the Epicor application must 
be set up in this program. 
 
All users must have a defined user ID, name, and password. In this program, you can also 
define addresses, phone numbers, and other company information. 
 
Users are commonly created by the Epicor application implementation team.  The system 
administrator grants security permissions based on the user's role in the company. 
 

Objective/Comment To create user account 

Requirement The user must have access to System Setup module 

Navigation Path System Setup → Security Maintenance → User Account Security 
Maintenance 

Responsibility with System Administrator 
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1.  Click on the New icon, select New User 

Type the ID of the user in the User ID field 
NOTE: It is recommended for the ID of all users to be unique. Example of most useful 
format is firstname.lastname 

2.  Type name of the user in the Name field. 

3.  Fill in additional fields for the this user such as Address, City, Phone Number 

4.  Navigate to Options tab 

5.  Put a tick on the following check boxes 
Allow Password Change 
Allow Enterprise Search 
Allow Epicor Web Access 

6.  Navigate to Group Tab 

7.  Assign user to available groups by selecting the group(s) available on the left and 
move it to the right pane using the right arrows. SAVE 

8.  From the New icon, select New company 

9.  On Company tab click the dropdown arrow; select a company on which the user will 
be designated to. 

10.  SAVE 
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11.  Repeat step 8 to 10 if user belongs to more than 1 company 

12.  Navigate to Detail tab; uncheck the Disable User Account checkbox to activate the 
user account. 
Save and exit the form 
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Menu Maintenance 

 
Use Menu Maintenance to customize the menu interface throughout the application. User 
can be assigned specific menu/module/program(s)/report(s) within a company. 
 
Menu security is considered the highest level in which security privileges are set. Security 
established at this level allows a folder or program to not display on the Main Menu for any 
number of security groups or specific defined user.  

 
This section highlights key fields and areas in Menu Maintenance. 
 

Objective/Comment To define User Security Privileges 

Requirement The user must have access to Menu maintenance 

Navigation Path System Setup → Security Maintenance → Menu 
Maintenance 

Responsibility with As per User Security Matrix 

 
1.  Navigate to Security tab 

2.  Expand the Main Menu on the left side of the form to choose Modules to assign 
security. 

3.  Use Allow Access sheet to grant security privileges and Disallow Access sheet to 
restrict security privileges to user(s) 
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Move user(s) and or Group(s) to Selected Groups/Users pane to specify 
Groups/Users designated to particular Menu/Module/Program 

4.  Uncheck/Check the Allow or Disallow Access to all group/users in the respective 
sheets to designate the particular Menu/Module/Program to all groups/users. 

 
NOTE: 
Security tab 
This is the internal security ID and description of a module, submenu, or program. The Security 
ID field is display only. 
 
Security Manager Only 
Select this check box to indicate that this module or program is restricted to security 
managers only. Only users selected as a security manager in User Account Maintenance have 
access to this option. 
 
Allow/Disallow Access to All Groups/Users 
Select the Allow Access to All Groups/Users check box on the Allow Access or the Disallow 
Access sheet to select all the groups and users in the Groups/Users list. 

 
Allow Access 
Use this sheet to grant access to a module, submenu, or program to certain groups and users. 
All security groups and users display in one of two categories - Groups/Users or Selected 
Groups/Users. 
 
Disallow Access 
Use this sheet to prevent access to a module, submenu, or program to certain groups or users. 
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General Ledger 
 
General Ledger functionality is the central depository where all transactions posted from 
various modules update account balances. 
 
During implementation, not many setup steps outweigh the importance of defining a 
company's chart of accounts. In the General Ledger (GL) module, COA definition is a critical 
factor that can impact how a business operates on a day-to-day basis. 
 
At the core of the general ledger lies a company's COA, or ensemble of GL account numbers. 
Each company has the ability to create multiple charts of accounts. On the outer walls of the 
accounts are unique segments, categories, allocations, references, and configurations which 
define each account the chart contains. The design of each wall significantly impacts the 
ability to easily prepare financial reports for each area of business in a company. 
 
The fiscal calendar definition also greatly affects how transactions display within reports and 
also how they post to the general ledger.  
 
The General Ledger module interface with all sub ledgers and is used to maintain account 
balances to facilitate financial reporting and analysis. 
 

Application Setup 
 

Several maintenance programs located throughout the Epicor application affect a company's 
general ledger process flow. Application Setup focuses on the essential company 
configuration and General Ledger module maintenance items user must complete prior to 
processing transactions that affect the general ledger. 

Chart of Accounts Structure Maintenance 

 
Chart of Accounts structure maintenance defines the segment structure and characteristics 
for each Chart of Accounts (COA) user use within the current company. The application uses 
COAs to control account entry. 

Characteristic of Chart of Accounts 

 Each account can have up to 20 definable account segments. 

 Each segment can be up to 50 characters in length. These segments can be natural, 
controlled, dynamic, and optional for data entry. The segments can also display in 
any order. 

 The maximum length for an account is 200 characters, including delimiters. 

 Each company book must have at least one COA 
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MoFP – GF will maintain at least two Chart of Accounts, Main Chart of Accounts for normal 
business operation and the Reporting Chart of Accounts for GF reporting 
requirements.whenever necessary additional Chart of Accounts can be added. 
 
The Main Chart of Accounts will consists of Eight controlled segments as seen below; 

Segments Segment Components Character 

1.  Natural Account (GFS Code) 8 

2.  Implementers 3 

3.  Budget Classification 3 

4.  
Grant 3 

5.  
Activity 7 

6.  
Fund Source  2 

7.  
Location Level 3 

8.  
Geografical Location  12 

The Reporting Chart of Accounts will consists of seven controlled segments as shown below; 

Segments Segment Components Character 

1.  Cost Grouping 1 - 2 

2.  Cost Inputs  3 - 5 

3.  Grants 9 

4.  
Implementer 3 

5.  
Module/ Objectives  2 - 3 

6.  
Intervation 2 - 3 

7.  
Activities  7 
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XXXXXXXXXXXXXXXXXXXX 

 
 

 

Create a Chart of Accounts Structure 

Objective/Comment To define Chart of Account structure 

Requirement The user must have access to Chart Of Account maintenance form 

Navigation Path Financial Management → General ledger → Setup → Chart of 
Accounts 

Responsibility with System Administrator 

 

Screen /Form Chart of Account Structure Maintenance 

1 From the New menu, select New COA. 

2 Enter the COA ID e.g. MAIN , Description, e.g. Main Chart Of Accounts, 
and  Separator Character (-) 

3 Click on the Create Default Categories checkbox to create nature of 
transactions which will be used on natural accounts such as Expense, 
Revenue etc 

4 Save 

5 From the New menu, select New COA Segment. 

6 Enter the Name, Abbreviation, Maximum Length, Minimum Length. Save 
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7 Use steps 5 -6 above to create all COA segments. 

8 Exit Chart of Account Structure Maintenance. 

 
Note:  
The first segment is always the Natural Account by default. Other segments offer additional 
options that are auto selected or disabled when creating the natural account segment. 
 

COA Category Maintenance 

COA Category Maintenance defines chart of accounts (COA) categories associated with 
natural accounts (GFS Codes) in Account Segment Values. This association determines how 
the Epicor application maintains account balances and the accounts that supply financial 
statement values. 
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Objective/Comment To define COA Category 

Requirement The user must have access to GL COA 
Structure maintenance form 

Navigation Path Financial Management → General ledger → 
Setup → COA Category 

Responsibility with As per User matrix 

 
 

From Screen /Form COA Category Maintenance 

1 Select the New icon 

2 Enter the  Category ID and Description 

3 In Type section, Select Balance  Sheet or Income Statement Check 
Box depending with the nature of your category. 

4 In normal Balance section, Select Debit or Credit check box. 

5 Select Parent Category 

6 Save 

7 Repeat the process for the rest of categories. 

8 Exit COA Category Maintenance 
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Account Segment Values 

Segments in the chart of accounts can be natural, controlled /dynamic and mandatory/ 
optaional. Each segment has the option to be self-balancing. The self-balancing segment is 
one which automatically posts a balancing journal when a transaction occurs between two 
values defined for the segment.  

 
Natural Account refers to the lowest level of detail at which financial information is recorded 
based on the nature of the expense, revenue, asset, liability, or equity being recorded. This 
segment is mandatory and associate with the category to which determine both account 
balance and the accounts that provide financial statement values. 
 
Controlled Segment is other defined segment in chart of account apart from natural segment. 
 
Dynamic segment is used for references business entity to relate one segment to another 
business object in the system like Customers or supplier or project. 
 

How to Create Chart of Account Segment Value 

Objective/Comment To define Account Segment Values 

Requirement The user must have access to Account Segment Value 
form 

Navigation Path Financial Management → General ledger → Setup → 
Account Segment Values 

Responsibility with System Administrator 
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Screen/Form 
Usage: 

Account Segment Values 

1. Click the New icon and Select New Value. 

2. Depending on the segment that has been selected, Type the segment value 
in the segment value field and description of that segment in the 
Description field. 

3. By default all new created segments are put as Active. Remove the 
checkbox if the segment is no longer active.  

4. Click Save and Exit the form. 

Generating GL Account 

Use the General Ledger account, Segment values to identify the accounts the system should 
build. Enter the range of values the system should use for each account segment in the 
corresponding form and through fields. 
 
General Ledger builds the Chart by bringing together every possible combination user define 
in the Segment Values. 
 

Objective/Comment To generate a Chart of Account 

Requirement The user must have access to General Ledger Account form 

Navigation Path Financial Management → General ledger → Setup → General 
Ledger Account Maintenance 

Responsibility with System Administrator 
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Screen/Form 
Usage: 

General Ledger Account Maintenance 

1. Make sure that on the Chart of Account field, it is selected Main Chart of 
Account 

2. On the Menu bar, Click on Actions and Select Generate 

A new sub form will appear 
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX 

 
3. Tick Create New Accounts Only check box. 

4. Use the check box on Seg Value Selection column by selecting  each 
segment as per the Chart of Accounts. 

5. Click Generate button to generate the accounts codes. 

6. User can also use the Preview tab to preview the string of the GL accounts 
which will be created before clicking Generate.  

7. A pop up message will display the number of accounts created. Click Ok. 
Close the form. 

8. On the Detail sheet, zoom on GL Account and select accounts generated. 
The List Tab contains the values already created in the System. 

9. Save and Exit. 

Fiscal Calendar 

A fiscal calendar defines MoFP – GF calendar in relation to financial reporting. Fiscal Calendar 
Maintenance supports multiple calendars with one calendar defined as the Main calendar. 
Only one calendar can be assigned to each defined GL book. Each calendar can start on any 
date, have any number of periods, and be any length necessary. 
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Fiscal Calendar Maintenance contains a sequence of fiscal years. Fiscal years in one fiscal 
calendar cannot overlap and there may be no gaps between years. Each fiscal year contains a 
number of periods. 

Once user creates a fiscal year, fiscal periods can be generated for it using the Generate 
Periods action. 

For the purpose of MoFP-GF (Grant management system), there will be ceated two different 
fiscal calenders, the Main Calender and the Operational Calender, the Main calender will 
consist of the entire grant period of 3 years with 36 periods. 

 
 
The fiscal periods are seen below. 
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 while the Operational calender will have each of the 3 years created separately as 1 fiscal 
year with 4 periods (Quarters). 
 

 
 
The fiscal periods are shown below 

 
Repeat the procedures below for remaining three fiscal years (2018/2019, 2019/2020, and 
2020/2021)  
 

Objective/Comment Defining Fiscal Calendar and Periods 

Requirement The user must have access to Fiscal Calendar form 
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Objective/Comment Defining Fiscal Calendar and Periods 

Navigation Path General ledger → Setup → Fiscal Calendar 

Responsibility with As per user matrix 
XXXXXXXXXXXXXXXXXXXXXXX 

 
 

Screen/Form 
Usage: 

Fiscal Calendar Maintenance 

1. On the new icon select new Fiscal Calendar. 

2. Type a code and description which will represent the fiscal calendar. 

3. Click Save. 

4. On the new icon Select New Fiscal year. 

5. Type the fiscal year, start date, end date and the number of periods in that 
fiscal year. 

6. Click Save. 

7. On the Menu bar, Click on Actions and Select Generate Fiscal Periods. 

8. On the generate period form, indicate period duration. 

9. Click Generate. 

10. A pop up message will display the number of periods generated. 

11. Click OK and Exit Fiscal Calendar form.  

 Note: You can repeat step 4 to 10 to generate as many fiscal year as 
possible 

Book Maintenance 

Book Maintenance defines a company's books. A book sets the currency, chart of accounts, 
the fiscal calendar, and the default Retained Earnings account used to generate its financial 
statements. 

For the purpose of MoFP – GF there will be three books for Operations and three books for 
Reporting that will be maintained. 

1. Main Book     1.1 Reporting Book –Main  
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2. Budget Book – Expenditure  2.1 Reporting Book - Exp Budget 
3. Imprest Book    3.1 reporting Book - Imprest 

 

Number Book ID Name Functions 

1. Main Main Book Main function of the organization 

2. Budget Budget Book Captures budget transactions 

3. Imprest Imprest Book Capture imprest transactions 

 
The main book is the entity’s functional book, whereas a budget book is a memorandum book. 
 

Objective/Comment Defining Books 

Requirement The user must have access to Book Maintenance form. 

Navigation Path Financial management  →  General ledger → Setup → 
Book 

Responsibility with System Administrator 

 

 
 

Book Mapping 

After all operational books are users will be required to link the operational books with the 
reporting books, this mapping allows the system to create journal entries for all transactions 
which are created and or posted on the Operational Books, the screen shot below illustrate 
how to achieve the mapping. 

Steps: 
I. While on the Book Mainetance window, Navigate to Posting Tab -> Source Book 

II. From drop down arrow, select New Link from Source Book 
III. On the Map GL Transactions from Source Book field select the source book (Main 

Book, Imprest Book, or Budget Book) to be linked with the reporting book. 
IV. On the Use COA Map, select the Mapped COA  
V. On the Transactional Currency, leave default 
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VI. On the GL Transaction Configuration, Click Enable All, then Click on the Update 
Transactions Types, wait for a few minutes the system to update the posting rules 
Note: Repeat the process above for all books mapping. 

 
 

Screen/Form 
Usage: 

Book Maintenance 

1. Click New button on the Standard toolbar. 

2. Enter Book ID. This value displays within various reports and programs. 

3. Enter the concise Description for the book. This value displays on various 
drop-down lists throughout the application. 

4. Select the Main Book check box to indicate the current book is the default. 
This book automatically displays on all reports and trackers for MoFP – GF. 
For MoFP – GF, the default book is the Main Book. If user no longer wish 
to use the book, select the Inactive check box. Then users can no longer 
enter journal records against this book. 

5. Use the Type field to determine the primary function of the book i.e. A 
Standard book which records financial activity of the entity and has no 
relationship to other books. 

6. Use the Chart of Accounts drop-down list to define the Chart of Account 
user wish to use with the book. Each book can have a different COA or 
several books can share the same COA. 
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Screen/Form 
Usage: 

Book Maintenance 

7. Select the Fiscal Calendar user wish to use with this book. These calendars 
define the fiscal period used by the application to record transactions. 

8. Use the Book Currency drop-down list to define the currency of the book. 
The book currency shall be used on financial reports 

9. Click on the Retained Earnings sheet to define the standard account used 
for retained earnings from the book. 

10. Click on the Validations sheet to define how errors are handled when 
journals are posted to the book 

11. Then, Click Save on the standard toolbar and Exit the form. 

12. Repeat the same process for other books, except that Do not tick main 
book checkbox. 

Journal Codes 

Journal Code Maintenance defines codes used to group journals associated with posting 
processes. 
System journal codes can apply to journals through the association of a posting process with 
a GL control. User can then track and report on journals by code. Some posting processes use 
default codes when a GL control does not supply a Journal code. 

 
 

Objective/Comment To create Journal  Code 

Requirement The user must have access to Journal Code form. 

Navigation Path Financial management  →  General ledger → Setup → Journal 
Code 

Responsibility with Accountant 

 

Screen/Form 
Usage: 

Journal Code Maintenance 

1. Click New button on the Standard toolbar. 

2. Enter Journal Code ID. 

3. For user defined journal, untick system journal checkbox. 

4. Type in description. 

5. Click Save on the standard toolbar and Exit the form. 
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GL Control Code 

GL Control Maintenance defines the accounts and a journal code available to application’s 
posting processes. It specifies the books and the accounts used to post journals. GL controls 
use account context to specify the books and accounts to which journal post. Posting rules 
use the account information to define journal details. 
 

Objective/Comment To create a new GL Control Code 

Requirement The user must have access to GL Control Code form. 

Navigation Path Financial management  →  General ledger → Setup → GL 
Control Code 

Responsibility with Accountant 

 

 
 

Screen/Form 
Usage: 

GL Control Maintenance.  

1. On Type field, choose GL Control Type, Enter the Name and Description for 
GL Control. These values display within various programs, use them to 
identify the specific GL control. Save. 

2 Click New on the standard toolbar. 

3. Define the Code and Description in the two empty forms respectively. SAVE 

4. Expand on the left side of the form and select Account Context to select 
Main Book 

5. Click on the Account button to find and select the account to attach the GL 
Account. 
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Screen/Form 
Usage: 

GL Control Maintenance.  

6. When finish, Click Save on the standard toolbar. This completes the process 
of creating Posting Codes (GL Control Codes) and attaching the posting 
codes with the relevant books. 

 

General Operations 
 

Earliest Apply Date 

The Earliest Apply Date is the first date on which user can apply any financial transaction with 
a company or within a module/transaction type. When user set up a new company, ensure 
the Earliest Apply Date value is on a date or period before the date user will load financial 
data into the Epicor application. This prevents errors from displaying when user enter or 
import financial data into user new company. 

Budget Entry 

 

Objective / 
Comments 

To capture MoFP – GF approved Budget. This is done on a yearly basis. 

Navigation Path Financial Management  → General Ledger → General Operations→  
Budget Entry 

Responsibility Accountant 
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No Budget Entry 
 

1.  Click on menu icon and Select File from the dropdown list.  

 

2.  From File Menu, Select New. Choose New Group  

 
3.  Group ID will auto generate. 

 
4.  Change the Apply Date within the Fiscal Year. 

 

 
5.  Save 

6.  Go to Menu Icon → File → New → and Select  New Journal 
 

7.  Enter the budget description in the Description Field. 
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No Budget Entry 
 

 
8.  Under Comment Tab. Enter the Full detail of your budget. This is mandatory. 

 

9.  Save. Legal number will be generated. 
 

 
 
10.  From File Menu, Select New. Choose New Journal Line. 
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No Budget Entry 
 

11.  Right click on G/L Account field, Select “Open With”, choose General Ledger Search. Search 
for and Select Expenditure GL Accounts to be Debited. 
 

 
12.  Enter the amount on Debit site and SAVE 

13.  Repeat process/steps number 10 to 12 for every GL Expenditure line you append their 
respective budget. 

14.  SAVE 

16. Click Auto Balance button to enter the budget control account to be Credited, to complete 
the Double Entry.   

17. SAVE 

18. Click Menu icon, from Menu Bar. Click Actions Menu from the dropdown list. Select Print Edit 
List to view the correctness of the double entry process for the posted transactions. 
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No Budget Entry 
 

19. Check the Submit For Approval box. Accept the pop up message by click YES to proceed. 
 

 

 SAVE. A message will appear prompting that the submission for approval is successful. Click 
OK on the message window.  

  
20. File and Select Exit in the Menu Bar. To close the Budget entry for, while waiting for the 

approver to approve. 

 
 

Budget Approval 

 

Objectives/ 
Comments 

To Approve MoFP – GF Annual Budget. 

Navigation 
Path 

Financial Management → Approval Management → General Operations 
→ Approval Process 

Responsibility As Per MoFP – GF User Matrix 
 

Screen
/Form 

Approval Process  

1 
Select the Search Button and Select the respective entry to be approved. Each 
entry awaiting approval will feature module name and approvers’ name. 

2 Select Child Tab, followed by List tab. 

3 Tick the Action check Box 
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4 SAVE 

5 Navigate back to Detail Tab and select the drop down arrow to select Approve 

 

 
 

NOTE: When it happen while putting a check mark in the List window and an error message 
occurs saying ‘’Row has been modified by another user’’, user should click Ok on the 
message and refresh the page and put again the check mark. 
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Budget Posting Process 

Objectiveness/Comments To Post Budget 

Navigation Path Financial Management → General Ledger → General 
Operation → Budget Entry 

Responsibility As Per MoFP – GF User Matrix 

1 Group ID. Search and select the respective budget group to 
be posted. 

2 Select Journal Tab, Header. A tick will appear in the 
Approved box. 

3 In the Menu Bar, go to Action and Select Post. 
 
 

Budget Reallocation 

Budget Reallocation refers to the authorized transfer of the approved budget from one 
expenditure line item to another expenditure line item. 
 

Objective / Comments For Budget Reallocation 

Navigation Path Financial Management → General Ledger → General 
Operation → Budget Reallocation 

Responsibility Accountant 

1 Click on the new icon and Select New Group. 

2 Group ID will automatically generate. 

3 Select the required Apply Date. 

4 SAVE 

5 Click on New icon and select New Journal 

6 Enter the description and Comments 

7 Select the Within Vote checkbox followed by MoFP – GF in the 
Vote dropdown 
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Objective / Comments For Budget Reallocation 

 
8 SAVE 

9 Click on new icon and select New Journal Line 

10 Use the GL Account field to attach the GL Account by right click 
and select the GL Search. 

11 On the right sde of the system, use the amount field to capture 
amounts by Debit to Increase and Credit to decrease 

12 Once the journal is balance follow the similar procedures of 
submitting the transaction for approval and posting. 

13 System will check for budget balance for any GL Accounts 
which will be credited. 

 
 

  



Ministry of Finance and Planning Tanzania - MoFP, 
IFMS –Impementation for GF Recipients,  
Epicor ERP 10.2 Training Manual, 
January, 2020. 

 

© Soft-Tech Consultants  Page 48 

Supplementary Budget 

Objective / 
Comments 

To capture Supplementary Budget 

Navigation Path Financial Management → General Ledger → General Operation → 
Supplementary Budget 

Responsibility Accountant 

 
 Click on the new icon and Select New Group. 
 Group ID will be generated automatically. 
 On the Apply Date change the Apply date accordingly. The Apply Date 

determines the period which the transaction posts. 
 Click save. 
 Click on the new icon and select new journal 
 In the Description field, type the description of the Supplementary 

budget. 
 Enter the full details of the supplementary form in the Comment tab 

 Click Save. Legal number will automatic generate. 
 Click on the new icon and select new journal line. 
 On the detail sheet, G/L account field zoom the account code user want to 

add budget and enter the amount on the debit side. 
Comments tab, write line comments for every GL Account line you append. 
Save. 

 Append more line items by selecting a new journal line, zoom the account 
code, and enter the amount. Repeat the process  for all accounts user wish 
to add budget or use Copy and Paste facility. 

 If there are no more accounts to debit,  click auto balance and select control 
account to credit the amount. 

 Click Save. 
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Objective / 
Comments 

To capture Supplementary Budget 

 Print the Edit List to view the correctness of user Journal Entries. 
 Check Submit for Approval box. 

 
 
NB: Approving and posting of Supplementary budget follows the standard steps of 
approving and posting budgets as illustrated above 

Review Journal 

The Review Journal is an optional program that adjusts, re-validates, cancels, and posts 
accounting transactions. Typically, review journals are used to locate posting errors and 
debug posting rules. 
 
Menu Path 
Financial Management →General Ledger →General Operations →Review Journal 
 
 

Close Period Entry 

Close Period Entry allows user to close both ordinary and closing period’s specific for each 
book in User Company’s general ledger (GL). If user close the last closing period in the fiscal 
year of a book, all previous periods (ordinary and closing) close automatically. 

 
Menu Path:  
Financial Management →General Ledger →General Operations →Close Period Entry 

 
 
Although Close Period Entry defines a period as closed, the GL transactions for that period 
remain in user database. User can always post transactions to previous and future periods. If 
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user need, user can also print financial statements for any closed period. To prevent book 
updates in certain periods, use Earliest Apply Date. 
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Screen/Form 
Usage: 

Close Period Maintenance 

1 
In the Book field, select Main Book. The fiscal calendar created and 
assigned to the selected book in previous workshops, automatically 
populates the Fiscal Calendar field. 

2 
In the Fiscal Year/Suffix field, enter the current calendar year and press 
Tab. 

3 Select period one's Closed check box. 

4 

Read and understand the warning message that displays. 
The message advises that preceding periods in the selected year are 
open, and asks if user would like to continue. 

 

5 In the Warning window, click Yes. 

6 Click Save and exit Close Period Entry. 
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GL Native Reports and Trackers 
Transactions created in any of the modules mentioned above. User can filter this report for a 
specific fiscal period or for any date range, and can display transactions, or any combination 
of these. 

Book Listing 

Menu Path: 
Financial Management → General Ledger → Reports → Book Listing 
Use Book Listing to view the book listings for the company. 
 

Chart of Accounts Listing 

Menu Path:  
Financial Management → General Ledger →Reports →Chart of Accounts Listing 
Use the Chart of Accounts Listing to print a master list of the COA files for the active company. 
All accounts are listed, in order of account category, with the normal balance displayed. 
 

General Ledger 

Menu Path:  
Financial Management →General Ledger →Reports →General Ledger 
The General Ledger Report lists detailed or summarized information for any range of accounts 
and periods by the book. 

Journal Listing 

Menu Path:  
Financial Management →General Ledger →Reports →Journal Listing 
User Journal Listing to produce a list of detailed journal entries for the periods and journals 
user select for a specific book. 

Trial Balance 

Menu Path:  
Financial Management →General Ledger →Reports →Trial Balance 
Use the Trial Balance Report to print balances from user trial balance account, as defined by 
user setup in Chart of Accounts Structure Maintenance. User can specify which segments and 
which balance level (detail or summary) to include in user report. User can also print period 
or daily balances. 
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The following type of information is available from the report, depending upon user 
selections: 

• Year opening balance 
• Period opening balance 
• Period movement debit amount 
• Period movement credit amount 
• Period closing balance 
• Average daily balance (for daily balance report) 

GL Trackers 

Journal Tracker 

Menu Path: 
Financial Management →General Ledger →General Operations →Journal Tracker 

 

Chart Tracker 

Menu Path:  
Financial Management →General Ledger →General Operations →Chart Tracker 
 

Journal Detail Tracker 

Menu Path: 
Financial Management →General Ledger →General Operations →Journal Detail Tracker 
 
The three trackers available in the General Ledger module all display information based on 

activity specific to a book and fiscal year. Once user select a book and a fiscal year (or fiscal 

period in some cases) to track, the Journal Tracker displays information for the specific journal 

code user select, the Chart Tracker displays information on specific accounts chosen, and the 

Journal Detail Tracker displays current information about a specific journal record.  
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Approval Management 
This module is very important for the case of an entity which requires user management in 
Approval rather than automatic approval of transactions. The module can interact with 
several transactions in the system such that, a transaction can be processed further before 
user approval. For example an AP invoice can’t be posted after issue unless first submitted for 
approval and get approved. 
 

Application Setup 
Navigation Path: Financial management -→ Approval Management → Setup → Approver 

Module 

Transaction Type 

 

 
 

 Add new Transaction Type 

 Provide the description 

 In case required book details then select book from “Select Book” 

 Save and Exit 
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Note:- In the case of budget entry approval or budget related transactions approval book is 
mandatory. 

Approver Maintenance 

Navigation Path: Financial management → Approval Management → Setup → 

Approver Maintenance 

 Add new  

 Search and select the approvaer on the Approver ID 

 In case alternate approver required then search Ält. Approver ID” after 

selecting the approver. Then enter the start and End Dates of this 

altenative. 

 Save and Exit. 
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Routing Rule Maintenance 

Objective / 
Comments 

To Creat Routing Rule 

Navigation Path 
Financial management → Approval Management → Setup → 
Routing Rule Maintenance 

Responsibility As per User Matrix 

 

 

Screen/Form 
Usage: 

Routing Rule Maintenance 
 

1 From Menu Icon→File → Click New. Routing Rule tab is activated.  

2 Enter “Rule ID” in the Rule ID field 

3 Click Transaction Type button, Search and Select required transaction 
type. 

4 Check the checkbox for “Rule Applicable to all segments” in case all 
segments of transactions will get approved by approver. 

5 Check “Enable Rule” box.  

6 Click Book ID button, Search and Select required Book ID. 

7 Click Disapprover ID button, Search and Select required disapprover.  

8 Click Save. 

9 Go to Detail Tab. 

10 Click the drop down arrow from from the Select field, and select 
“Approvers” option.  
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Screen/Form 
Usage: 

Routing Rule Maintenance 
 

 
11 Click the Select button. The remain half of the form will open up. 

12 Check “Set Sequence Required” box. 

13 Click Add button below. To add approver.  

14 Click on Approver ID button, search and select the required approver.  

15 Sequence Number, will auto generate.  

16 Enter Group Sequence number in Group Sequence field. Group sequence 
number is based on approval hierarchy.  

17 Enter approval limits or ceiling amount in “Limit From” field and “Limit To” 
field.  

 
18 Click Save button.  
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General Operations 

Approval Process 

This program is used to approve transactions for further processing 
 

Objective / Comments Approval of Transactions 

Navigation Path 
Financial management → Approval Management → 
General Operations →Approval Process 

Responsibility As per User Matrix 

 

Procedure 1 

 

Click Search to initiate Search Form 
The search form will appear for transaction listing 
Click Search again on the Search Form to list the transactions eligible to approve by the 
current user 
Select the transaction(s) then click OK to load them to the Approval Program 
 
Procedure 2 

 

1. Select Approved on Detail Sheet 
2. Navigate to Child  then click List to see all the transaction selected 
3. Check (tick) the box(es) on Action column to make imply the transactions are 

approved 

1 

2 

3 
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4. Click Save icon from the menu bar to save the changes 
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Exception Send to DEO 

This program is used to un-approve transactions. The approved transactions are moved back 
to the initiator of the data entry for modification or removal of the transaction. 

Objective / Comments Approval of Transactions 

Navigation Path 
Financial management → Approval Management → General 
Operations →Exception Send to DEO 

Responsibility As per User Matrix 

 

Procedure 1 

 

1. Click Search to initiate Search Form 
2. The search form will appear for transaction listing 
3. Click Search again on the Search Form to list the transactions eligible to disapprove 

by the current user 
4. Select the transaction(s) then click OK to load them to the Approval Program 

 

Procedure 2 

1 

2 

3 
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1. Navigate to Child  then click List to see all the transaction selected 
2. Check (tick) the box(es) on Send to DEO column to emply the transactions are 

disapproved 
3. Click Save icon from the menu bar to save the changes 
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Accounts Receivable  
 
Accounts Receivable (AR) module's concepts and reporting tools include maintenance 
program setup, various AR processes, and how to recognize the impact these processes have 
on the general ledger (GL). The discussion follows the process and transaction flow for the AR 
cycle, from Invoicing to receipting with appropriate adjustments. 

Application Setup 

Customer 

Use the Customer → Detail sheet to enter the primary information about the customer, 
including a customer identifier and the customer’s main address. There are other options user 
define here as well, such as the customer’s language and the customer’s main salesperson. 

 

Objective / Comments Creating Customer 

Navigation Path 
Financial management →Account Receivable→ Setup → 
Customer 

Responsibility As per User Matrix 
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Screen/Form 
Usage: 

Customer Maintenance 

1 Click on the new icon, select New Customer in order to create a new 
Customer. 

2 Type the Customer ID in the Customer field. 

3 Type the name of the Customer in the Name field. The Approved check 
box is selected by default when entering a new customer. 

4 In Type, Zoom and Select Customer type. 

5 Enter the Customer’s Address. 

6 In Country field, Zoom and Select a country. 

7 In the Territory field, click get territory. 

8 Put a check mark on the Statement field for this customer so that user can 
view customer’s statement report anytime. 

9 Go to Billing tab and update extra information regarding to this customer 
such as TIN number in the TAX ID field. 

10 Go to Billing→ Credit→Credit Detail sheet and un tick the Credit Hold 

11 Click on the new icon and select New GL Control, insert the type and 
control. 

12 Type in the rest of appropriate information. 

13 Click Save and Exit Customer form. 

 

Terms 

Use Terms Maintenance to establish conditions that define how customers pay their 
invoices (for example, discounts, number of payments, and payment frequency). Terms 
define the due dates, payment frequency, applicable discounts, and number of payment 
installments. Each accounts receivable (AR) code defines a time period and a discount 
percentage period schedule. 
 
Main Path: Accounts Receivable →Setup→Terms 
 
To begin setting up the selling terms, select one of the following term code types: 

 
1.   Days 
2.   Day of Month 
3.   End of X Month(s) On Y Day(s) 
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Legal Number 

 

Use Legal Number Maintenance to define how legal numbers are set up for documents, 
such as invoices, packing slips, and master packs. 
 
 Legal Number 

1.  Click on the drop down and select New Legal Number  

2.  
On the Legal Number ID type the ID and Description of the same, example AR 
Invoice and AR Invoice. 
 
 3.  Select the Number Type corresponding to the transactions example AR Invoices. 

4.  
On the Prefix Type select User Defined and on Default Prefix put the initial 
alphabets for the legal number example INV 

5.  Leave the Generation Type to remain as Automatic. 

6.  Click the check box for Display Number After Generation. 

7.  Define the length of the legal number, example 8 characters. 

8.  
If the organization wishes to exclude Fiscal Periods and Fiscal Year in the Legal 
number, then put the checkbox in the 2 boxes. 

9.  

Navigate  to  document  type  and  select  the  document  type  for  particular  
legal number and assign. NB: System Administrator needs to create Documents 
Type for all legal numbers. 
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General Operations 

AR Invoice Entry 

The AR Invoice Entry will be used to bill customers where applicable. 
 

Objective/Comment Processing AR Invoices 

Requirement The user must have access to Invoice entry form in Accounts 
Receivable. 

Navigation Path Financial Management → Accounts Receivable→ General 
Operations → Invoice Entry 

Responsibility with As per Matrix (i.e. MoFP – GF Functional Security matrix) 

 

 
 

Screen/Form 
Usage: 

AR Invoice Entry 

1.  Click on the New icon and Select New Group. The group ID will automatic 
generate. 

2.  Change the apply date and Invoice date if necessary. 
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Screen/Form 
Usage: 

AR Invoice Entry 

3.  Click Save. 

4.  Go to New icon and Select new miscellaneous invoice. 

5.  Zoom and Select Customer on Sold To Customer field. 

6.  Change the Currency in the Currency field if the invoice is for other 
currency than TZS. 

7.  Enter full details the narrations in the Comment field to appear in the 
report 

8.  SAVE 

9.  Click on New icon and select New Line. 

10.  Enter in brief the description of the Invoice in the Description field. 

11.  Type the quantity and unit price in the quantity and unit price fields 
respectively. Save. 

12.  Click the Get Default button then, right click in the Account field to search 
for a revenue account. Save once selected 

13.  Repeat step 9 to 12 if users need to append more than one account. 

14.  Click on the Action Menu, Group, Select  Edit List. 

15.  Print Preview to review the transactions and close the preview window. 

16.  Click on the Action Menu, Group, Print Invoices, print preview to preview 
the Invoice, print invoice. 

17.  Click on the Action Menu and Select Post. 

18.  Posting window appears. Click Submit, close the form. 
 

 

Cancellation of Invoice 
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AR Invoice Entry provides the ability to directly cancel a posted invoice. This results in 
creation of credit memo directly against the invoice selected for cancellation. This process 
copies all previous invoice lines and detail information into the credit memo. 
 

1. Automatic Creation of Credit Memo. 
 
Note: For this form to be active, System Admin should ensure the Bank Account is attached 
in the Company Configuration form under Modules-Sales-Order  tab in the Default Bank 
field. 
 
Menu Path: 
Financial Management→ Accounts Receivable→ General Operations→ Invoice Entry 
 

Steps AR Invoice Entry Form 

1. From the New menu, select New Group. System will automatic generate the 
Group ID. 

2. Change the Apply Dates & Invoice dates as per the Invoice issued. 

3. Click Save. 

4. From the Actions menu, select Create Cancellation Invoice. The Create 
Cancellation Invoice window displays 

5. In the Legal Number field, search and select the legal 
number of the issued invoice. 

6. Click on the drop down arrow for Document Type and 
select Credit Memos. 

7 Another window will open asking ‘Are you Sure’. Click Yes 

8. Review the Cancellation Invoice created and Note the amount being Negative. 

9. Enter the details relating to the cancellation on the Credit Memo. 

10. From the Actions menu, select Group →Post. The AR Invoice Post Process 
window displays. 

11. The AR Invoice Post Process window displays. Close the AR Invoice Post Process 
window 
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2. Manual Creation of Credit Memo 
 

Screen/Form 
Usage: 

AR Invoice Entry 

1. Click on the New icon and Select New Group. The group ID will automatic 
generate. 

2. Change the Apply Dates & Invoice dates as per the Invoice issued. 

3. Click Save. 

4. Go to New icon and Select New Credit Memo. 

5. Zoom and Select Customer on Sold To Customer field. 

6. Use the Ref Invoice and search and select the Invoice issued. SAVE 

7. Click on New icon and select New Line. 

8. Enter in brief the description of the Invoice in the Description field. 

9. Type the quantity and unit price in the quantity and unit price fields 
respectively as per the Invoice issued. Save. 

10. Repeat the step above if the invoice had more than one line. 

11. Click the Get Default button then, right click in the Account field to search 
for a revenue account. Save. 

12. Click on the Action Menu, Group, Select  Edit List. 

13. Print Preview to review the transactions to verify if the transactions have 
reversed. 

14. Click on the Action Menu, Group, Print Invoices, print preview to preview 
the Invoice, print invoice. 

15. Click on the Action Menu and Select Post. 

16. Posting window appears. Click Submit, close the form. 
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Cash receipt entry 

Note: Integrated Revenue Management System will be used to capture both Invoiced and 
Miscellaneous Invoices.  

 

Cash Receipt records payments made by customers or received from sources other than 
Customers. This can be Cash Receipt originating from AR Invoice or miscellaneous payment. 
 

Objective/Comment To record Disbursement Revenues 

Requirement User must have access to Cash Receipt Entry in the Accounts 
Receivable or in the Cash Management. 

Navigation Path Financial Management → Accounts Receivable→ General 
Operations → Cash Receipt Entry 

Responsibility with As per User Matrix 

 Click on the New icon and Select New Group 

 On the Group field, type the ID for the group. An ID for the group 
may be the disbursement receipt date. 

 Select bank account on the Bank Account filed. A correspondent 
Payment Method will display. If not, click the drop down and select 
the method to be used. 

 The Transaction Apply Date defines the date that is placed on the 
cash receipts within the group. The current date is displayed by 
default. If user need, Select a different date. 

 Click Save. 

 
For AR Invoice Receipt 

 Go to standard tool bar Click on the New icon and the Select New 
Invoice payment. 

 On the AR Receipt header sheet, fill all the necessary basic fields: 
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Objective/Comment To record Disbursement Revenues 

i. Check: Enter the Deposit number as per the receipt 
ii. Receipt Amount: Amount received. 
iii. Reference: Short description of the receipt 

Customer ID: Search and select the Customer with whom the 
payment is received from 

 Click Save. 

 Go to Invoice Selection tab and retrieve the invoices to be applied 
to. Apply the transaction by checking the selected box. 

 Click on Actions and Post the transaction to GL 

 Use IFMIS tool to print the report. 

For Non AR Cash Receipts (Miscellaneous Cash Receipts) 

 After step no 5. Click on New icon and select Misc Payment 

 On the Misc header, fill all the necessary basic fields: 
i. Check: Enter the Deposit number as per the receipt 

ii. Amount: Amount received. 
Reference: Short description of the receipt 

 Click SAVE 

 On the Account field right click, Open With and select General 
Ledger Search to search and select the GL Account 

 Once the Revenue account has been selected, Click on the Actions 
and select Post to post the transaction to General Ledger. 
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Reverse Cash Receipt 

Navigation Path: Accounts Receivable→General Operations→Reverse Cash Receipt 
 
Note: 

i. Reverse Cash Receipt reverse receipt originating from AR Invoice only. 
ii. Use Reverse Cash Receipt to reverse a posted cash receipt 

 

Screen/Form 
Usage: 

Reverse Cash Receipts 

1.  Click on Search Button. 

2.  Select Receipt user want to Reverse. 

 
 

3.  On Reverse Date select the date of Reverse. 

4.  

Click Reverse, ‘’Are you sure?’’ pop up message appear. 

 
5.  Click Yes, to proceed or No to cancel then exit the form. 
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AR Native Reports and Trackers 

This section focuses on the reports and trackers important to the AR process. Trackers are 
available in most modules and are located in the General Operations folder of a respective 
module. Many trackers display in multiple modules.  

Aged Receivable Report 

The Aged Receivables Report displays open Accounts Receivable (AR) invoices and sorts them 
into default aging columns which are defined in Aging Report Format Maintenance. The total 
on this report should reconcile with the ending balance of the AR GL account. 

AR Invoice Balance Report 

Use the AR Invoice Balance Report to display customer invoice balance information in a 
report format.  

User can filter using various criteria including Customer, Customer Group, GL Control, and GL 
Accounts. 

Customer Tracker 

Use the Customer Tracker to view information about a customer. Various sheets contain 
information pertinent to that sheet. Each sheet contains links to additional trackers. For 
instance, the Invoice sheet can take user to the Invoice Tracker. The Invoice sheet also 
provides the ability to see an online aging report for a selected customer. 

Cash Receipts Tracker 

The Cash Receipts Tracker displays information about cash receipt records in a Dashboard 
format. 

Invoice Tracker 

Use the AR Invoice Tracker to drill into selected invoices and get information for an invoice. 
This includes information such as the posted status, shipping information, payment activity, 
schedules, GL transactions, header and line item information, as well as any memos linked to 
the selected invoice. You can also track recurring AR invoices. 

Customer Statement 

Use Customer Statements Report to send out statement forms to customers to recap 
Accounts Receivable activity. Customers can then review their transactions. Customer 
statements can be printed at any time using any date range. 

AR Reconciliation 

about:UIApp/Erp.UI.ARInvoiceTracker.dll
about:UIApp/Erp.UIRpt.CustomerStatement.dll


Ministry of Finance and Planning Tanzania - MoFP, 
IFMS –Impementation for GF Recipients,  
Epicor ERP 10.2 Training Manual, 
January, 2020. 

 

© Soft-Tech Consultants  Page 73 

Use the AR Reconciliation Report to print a single report to assist in reconciling Accounts 
Receivable (AR) balances with the General Ledger (GL). The AR Reconciliation Report shows 
any differences between amounts and transactions that post to the GL and the AR sub-ledger. 
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Accounts Payable  

Use the Accounts Payable (AP) module to enter supplier invoices for purchases that user 
make and then create checks for the invoices to pay.  

The application can generate payments for all invoices due, those for a particular supplier, or 
only for specific invoices. If a supplier calls to discuss an invoice, user can have a complete 
information at user’s fingertips and that history can be kept indefinitely. 

 

Application Setup 

Supplier/Vendor 

Use Supplier Maintenance program to create suppliers records. Supplier’s records are used in 
several programs and are crucial for creating purchase orders and accounts payable invoices. 
 

Objective / Comments Creating Suppliers 

Navigation Path Material Management → Purchase Management→ Setup 
→ Supplier 
Or Financial Management →Accounts Payable →Setup 
→Supplier 

Responsibility As per User Matrix 
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Screen/Form 
Usage: 

Supplier Maintenance 

1.  Click on the new icon and Select New Supplier in order to create a new 
supplier. 

2.  Type the supplier ID on the supplier field. 

3.  Type the name on the supplier in the Name field. The Approved check 
box is selected by default when entering a new supplier. 

4.  Enter Tax Identification Number (TIN) in the Tax ID field and VAT 
Registration Number (VRN) on the Acct Ref. 

5.  The following fields are option while creating a new supplier record in 
the Detail  tab. 
Group: If the organization differentiate internal and external supplier 
Terms: Payment terms to be used while Invoicing 
Ship Via: Method of delivering the services/goods 
FOB: This can be left Not Applicable 
Payment Method: Method used for payment. 

6.  Go to Addres tab and enter the Address of the supplier to include P.O. 
Box, Phone Number, City etc 

7.  On New icon select New GL Control 

8.  Search and select the Type in the Type field and select AP Account 

9.  In the Control button click and search already predefined GL controls 
based on the supplier. 

10.  Click Save and Exit Supplier form. 
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General Operations 

AP Invoices Entry (Payment Voucher) 

Accounts Payable (AP) invoices are used to record and track payments made against linked 
shipping receipts, purchase orders and other miscellaneous AP financial transactions. 
 
Use AP Invoice Entry to record payments to suppliers. There are three types of AP Invoices; 

i. Miscellaneous AP Invoice 

ii. AP Invoice Originating from LPO 

iii. AP Invoice Originating from Imprest Module 

All AP invoices are created and posted through AP invoice groups. User can use this program 
to create both regular invoices and debit memos. Within regular invoices, each line must be 
assigned a specific type; the available types are Receipt Line and Miscellaneous Expense Line. 

AP Invoices Entry 

 

Objective/Comment Processing Invoices 

Requirement User must have access to Invoice entry form in Accounts 
Payable. 

Navigation Path Financial Management → Accounts Payable→ General 
Operations → Invoice Entry 

Responsibility with As per Matrix (i.e. MoFP – GF Functional Security matrix) 
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Objective/Comment Processing Invoices 

 
1. Click on the New icon and Select New Group. AP Invoice groups collects invoices 

and post them to the same GL fiscal period at the same time. 

 
2. 

On the Group ID system will automatically assign group number.  

3. In the Apply date field, change the date (where necessary) Click Save. 

4. Go to New icon and Select New invoice to record supplier invoice details for 
payments. 

5. Header sheet will automatically open, zoom and select Supplier on Supplier 
field, if supplier has reference PO, Zoom and select PO on REF PO field.  
The PO number, supplier code, and name will populate automatically. If supplier 
does not have reference PO then do not select any reference PO. 

6. Type the supplier invoice number on Invoice field. 

7. Update the Invoice Date, Apply Date and Description on the fields. 

8 In the Terms field drop down arrow select the appropriate terms applicable to 
the supplier. 

9 In the Payment Method drop down arrow, select the default method. 

10 In the Currency tab, select appropriate  currency if other than Tanzanian 

Shillings is being used. If the currency used is USD then user will need to attach 

the Exchange Rate. 
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Objective/Comment Processing Invoices 

11 Navigate to Comment Tab and enter comments pertaining to payment. This 

field  can be used to give more description of the PV if any. Save, to get a legal 

number. 

12 Click on New icon and select New Misc. Line for AP Invoice not originating from 
PO (or Debit memo).  

13 Fill all basic information for Line Invoice selected. Enter cost and quantity using 
Supplier Qty and Unit Cost fields and then SAVE 

14 Navigate to GL analysis right click on the Account and Open with GL Search as 
shown in the screenshot to enter appropriate expense account required. SAVE 

 
15 System will check the available budget balance in the account selected and will 

allow user to proceed if there is enough budget balance. 
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Objective/Comment Processing Invoices 

 
16 Repeat Steps 12 to 14 to append as many lines as possible. 

17 Navigate to summary sheet and tick “submit for approval” check box. 

If user select Yes, then will be required to Open IFMIS report and print 
Payment Voucher report using Legal Number from the form. 

If user select No the second prompt msg will appear in which will need to click 
Yes and SAVE 

 
18 The message that comes after will alert you that the submission for approval is 

successiful.Click OK to accept.  
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Approval of AP Invoice Entry 

 

Objective/Comment Approve AP Invoices 

Requirement User must have access to Approval Process form. 

Navigation Path Financial managemnt →Approval Management →General 
Operation →Approval process 

Responsibility with As per MoFP – GF Functional Security matrix 

 Approver should check correctness of Information both in 
supporting documents and payment voucher in the system 

 Approver will tick the box to select transaction, on Action then 
click “approve” if satisfied, alternatively click “Send to DEO” to 
return the PV to operator 1 for correction and re-submission for 
approval. 

 

Posting of AP Invoice Entry 

Screen/Form 
Usage: 

Posting of AP Invoice 

1 AP Invoice transaction can be posted by authorised staff who is given 
access right to post. 

2 User would need to search and select the group which contains the AP 
invoice to be posted. 

From Actions menu click Group → Post 

Dialog box “AP Invoice post process” will display. Click on File submit to post the Invoice. 

 
NOTE: Only Transactions which have been approved will be able to be posted. 

Procedure for preparation of LPO AP Invoice 

Screen/For
m Usage: 

Procedure for preparation of LPO AP Invoice 

Navigation Path: Financial Management →Accounts Payable → General Operations 
→AP Invoice Entry 

1 From the New menu icon, select New Group, system will automatically 

assign group number. 

2 In the Apply date field, change the date (where necessary), SAVE 

3 Click on New Invoice and In the Ref PO field, zoom and select PO 

number. After selecting PO number the following information will 
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Screen/For
m Usage: 

Procedure for preparation of LPO AP Invoice 

automaticaly load; Supplier ID, name, address, payment method, 

currency. 

4 In the Invoice field enter the invoice number. 

5 In the Invoice Date and Apply Date fields enter  the dates. 

6 In the Description field enter  invoice information 

 

8 
Navigate to Comment Tab and enter comments all description  

pertaining to payment. 

NB: This is a mandatory field to be recorded. 

9 Save, to get a legal number 

10 Go to New icon and select New Receipt Line, the following PO line will 
load where you will select line (s) to be paid. 
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Screen/For
m Usage: 

Procedure for preparation of LPO AP Invoice 

 
11 Check the box “select Line” on ‘’AP Invoice Uninvoiced Receipt Lines’’. 

The selected lines will shift below in the “AP Invoice Selected 
Receipts”.Then click “create lines”. This process will be done for 
selection of all lines which needs to be paid. 

12 After clicking the “create lines” button The system will take you back to 
the following window for AP lines 
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Screen/For
m Usage: 

Procedure for preparation of LPO AP Invoice 

 
13 For the correctness of this voucher, it is recommended to print edit list to 

check the correctness of information such as accounts, supplier, 
payment methods. 

From the Action menu -> select Group -> print group edit list 
14 After verifications, navigate to summary sheet and tick “submit for 

approval” check box. 

Follow the standards procedures of approving the AP invoice. 
15 For notes on reviewing, approving and posting of the invoice please 

refers to notes on sections Error! Reference source not found., 0, 0 

 

Procedure for preparation of Payment Voucher Relating to tax or 
any deductions. 

 
Procedures are the same as for AP Invoice above, with the following additional procedures to 
be followed after procedure number 15 of miscellaneous AP Invoice above. 
 

Screen/Form 
Usage: 

AP Invoice with Withholding tax 

1 Follow the standard procedures of preparing an AP Invoice as illustrated 
on section 0 

2 Before submitting the transaction for approval, click New icon and Select 
“New Header Tax Code”. Invoice taxes window will be active 



Ministry of Finance and Planning Tanzania - MoFP, 
IFMS –Impementation for GF Recipients,  
Epicor ERP 10.2 Training Manual, 
January, 2020. 

 

© Soft-Tech Consultants  Page 84 

Screen/Form 
Usage: 

AP Invoice with Withholding tax 

 

3 
In the Tax type,  select the appropriate tax type as per the type of taxes 
used in the organization, the withheld amount will automatically be 
deducted from the gross amount while VAT will add. 

4 

AP Invoice Edit List will reflect the deducted amount of tax withheld. Full 
account will be as follows: 

DR  Expense account 

CR  Creditors control (net amount to be paid) 

CR  Withholding account (amount withheld) 

 

Or 

DR                      Expense Account 

DR                      VAT Account 

CR                      Creditors control (net amount to be paid) 

 

5 Follow the standards procedures of reviewing, printing, approving and 
posting of the transaction above. 

 

Payment Process 

Use AP Payment Entry to pay AP invoices through cheque or electronic payments. After user 
enter the payments and process the cheques, user then record these transactions in General 
Ledger. 
 
Respective Accounting staff, such as Cashier, shall generate payments for only authorised and 
posted vouchers. The system will automatically assign a disbursement number (DISB) for each 
generated payment. But before generating payment, the system will validate the total 
payment amount against the cash book balance. 
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Objective/Comment To  Process Payment 

Requirement 
User must have access to AP Payment  entry form in Accounts 
Payable. 

Navigation Path 
Financial Management → Accounts Payable→ General 
Operations → Payment  Entry 

Responsibility with As per User Matrix 
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Screen/ 
Form Usage 

Payment Entry 

1.  
Click on the new icon and select New Group, group ID will automatically 
be generated. 

2.  On the Bank Account field, Zoom and Select Bank Account. 

3.  Enter the Payment Method used in the drop down arrow 

4.  Update the Payment Date accordingly. 

5.  
Click on the new icon and Select New Payment. An AP Payment Entry form 
will open. 

6.  On the Supplier field, search and Select the Supplier to be paid. 

NOTE: If the Payment Method used in the Group tab was Manual Cheque, system will allow 
users to enter manually the check number in the Check field. 
If the Method used was for check printing, the Check Number field will be faint and 
uneditable. 

7.  SAVE. System will generate the Legal Number 

8.  Click on the new icon and select New Invoice Payment. 

9.  
Go to Invoice Detail tab and click on the Invoice to search and select the 
Invoice to be paid. 

10.  Save. 

NOTE: If the amount being paid is as per the invoice then user after saving can proceed 
with next step. 
If user wants to pay partial the amount of the invoice then Enter manually the amount in 
the Gross Value field followed by SAVE. 

11.  Click on  the Actions Button  and Select Print Group Edit List. 

12.  
Preview the Payment Edit List to verify the bookkeeping entries, close Edit 
List. 

13.  

Go back to Header tab and tick the Submit For Approval checkbox. System 
will ask ‘Are you Sure’ click Yes to proceed and SAVE.  
 
System will automatic approve the system and the Approved box will have 
a tick in its checkbox. 

14.  
Click on the Actions button and Select Process Payment (for Cheque 
Printing) transactions. 

15.  

Verify the following Information displayed: 
i. Payment Date 

ii. Bank Account 
iii. Cheque number (user can override payment number by ticking on 

Override Payment Checkbox if the number is different from the 
check) 

iv. Report Style is as per the Bank Account used 

16.  Press on Print Icon, and select Print from Client to print a Cheque. 
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17.  

Another window will open. 
 

i. Put 1 on From Page and To Page put 1 
ii. Click on Page Setting Tab and ensure both Horizontal and Vertical 

Resolution have 600. 
iii. Tick Landscape box 
iv. Paper Size is Check Print 

 
Click Ok to Print the cheque. 
 

18.  
Once the transaction is printed in the printer, Go to Actions menu and click 
Post. If system asks for any verifications then click Yes followed by Submit 

Void Payment 

Void Payment Entry allows cancellation of unreconciled payments. 
 
NOTE:  

i. The GL, updates immediately after user click the Void button. 
ii. No group is used to void payments;  
iii. A voided transaction affects the original GL account numbers for the payment; 

however, the amount is reversed. If the original payment was for an invoice, AP is 
credited and the invoice begins aging again as of the original invoice date.  
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iv. Carefully consider the void date because this date drives the period to which the 
transaction posts. 

 

Objective/Comment Void Payment Entry 

Requirement The user must have access to Void Entry form in Accounts 
Payable 

Navigation Path Financial Management → Accounts Payable→ General 
Operations → Void Payment Entry 

Responsibility with As per User Matrix 

 
Screen/Form Usage: Void Payment Entry 

1.  Click Search (binoculars icon) on standard toolbar 
The Void Payment Search window displays. 

2.  Click Search and select Payment. 

3.  In the Apply Date field, select date. The date used should be the 
same as the Check Date. 

4.  Click on the Assign to assign the legal number. 

5.  Click Void. 
The “Are user sure?” Message displays. 

6.  In the message, click Yes to proceed with Voiding or No to cancel 

7.  Exit Void Payment Entry. 

 

Adjustment Entry 
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In some exceptional scenario, there may be issues with an incorrect amount which originated 
from the posted invoice. In this case, the next invoice needs to be adjusted to correct the 
amount. 
 
Use AP Adjustment to change the amounts of any open invoice. User can increase or decrease 
the invoice balance. The adjustment procedure is typically used to write-off the balance of an 
invoice that will never be paid. 
 

Objective/Comment Adjustment Entry 

Requirement The user must have access to Adjustment Entry form in 
Accounts Payable 

Navigation Path Financial Management → Accounts Payable→ General 
Operations → Adjustment Entry 

Responsibility with As per User Matrix 

 
 

Screen/Form 
Usage: 

Adjustment Entry 

1.  In Supplier field, search and select Name of the supplier. 

2.  In the invoice field, Search and select for the posted Invoice. 

3.  In the Apply Date, put the correct date of the adjustment. 

4.  In the Adjustment field, enter the amount to be adjusted. 

5.  In the GL Account field, enter the appropriate affected GL account. This 
should be the same as the one used in the invoice. 
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Screen/Form 
Usage: 

Adjustment Entry 

6.  Write a short description in the description field and enter comments in 
the comment field if required. 

7.  Then, Click Save. Saving the record automatically feeds the information 
both the Payables account and GL account selected in the record. 

8.  If the message informing user that the transaction is posted to the GL 
displays, Click OK. 

9.  Exit AP Adjustment Entry. 

 
 

Debit Memo 

1. Automatic Debit Memo 
 

Objective/Comment Automatic Debit Memo 

Requirement The user must have access to Initiate Debit Memo form 
in Accounts Payable 

Navigation Path Financial Management → Accounts Payable→ General 
Operations → Initiate Debit Memo 

Responsibility with As per User Matrix 

 

 

Screen/Form 
Usage: 

Automatic Debit Memo 

1. Click on New Icon to activate the form 
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Screen/Form 
Usage: 

Automatic Debit Memo 

2. Click on the AP Invoice Search to search an open AP Invoice 

3. Enter the Description 

4. Click on the Initiate Debit Memo box 

5. A pop up message will appear, Click Yes to proceed. 

 
6. Save and on Initiate Debit Memo field will change status to ‘’Submitted 

for Debit Memo’’. 
7. Wait for another 3 minutes and system will automatic generate a group 

in the AP Invoice form created by a user ‘Manager’. 
8. Close the form. 

 

How to Trace a Group Created for Automatic Debit Memo 
 

Screen/Form 
Usage: 

Automatic Debit Memo 

1. Open Invoice Tracker in General Operation for Accounts Payable 

2. Go to Summary Tab and Search and Select the Invoice which on the 
column of Debit Memo has a check box 
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Screen/Form 
Usage: 

Automatic Debit Memo 

 

3. Select the Debit Memo by clicking OK 

 

 
 

4. On the Group field copy the group ID created and post in the AP Invoice 
Entry 

5. Posting of Debit Memo follows the same procedures of posting. Debit 
Memo does not require to be approved. 

 
2. Manual Debit Memo 
 

Objective/Comment Manual Debit Memo 

Requirement The user must have access to AP Invoice form in 
Accounts Payable 

Navigation Path Financial Management → Accounts Payable→ General 
Operations → Invoice Entry 
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Objective/Comment Manual Debit Memo 

Responsibility with As per User Matrix 

 

Screen/Form 
Usage: 

Manual Debit Memo 

1. Open Invoice Entry form and Click New to activate the form. 

2. The Group ID will be automatic generated. 

3. Enter the Invoice Date and Apply Date accordingly. Save 

4. Click New Icon and select New Debit Memo 

5. On the Header tab search and select the Supplier. 

6. Enter the Invoice number for the Debit Memo. 

7. Update the Invoice date and Confirm Date 

8. Enter Description and Click on Ref Invoice to refer to the office 

9. SAVE 

10. Click on New Misc Line and enter the Quantity and Unit Cost as per the 
Invoice. 

11. SAVE 

12. Go to GL Analysis and attach the same expense account used in the 
invoice 

13. If the Invoice had any deduction Click on New Header Tax and attach the 
tax accordingly 

14. Repeat step 10 to 14 if there are any other Lines to attach. If not go to 
Actions menu bar and post the transaction. 
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Accounts Payable Native Reports and Trackers 
 

This section reviews native reports and trackers that relate to the Accounts Payable process. 

Aged Payables Report 

 
The Aged Payables Report displays open Accounts Payable (AP) invoices and sorts them into 
default aging columns which are defined in Aging Report Format Maintenance. The total on 
this report should reconcile with the ending balance of the Accounts Payable GL account. 
 
In addition, the Aged Payables Report can be aged using the invoice date or the invoice due 
date for select customers, select GL controls, and select currencies. 

AP Invoice Balance Report 

Use the AP Invoice Balance Report to display supplier invoice balance information in a 
report format.  

User can filter using various criteria including Supplier, Supplier Group, GL Control, and GL 
Accounts.  

GL Distribution Report 

The GL Distribution Report prints GL transactions created in the Epicor application and is used 
as an audit of GL transactions created in any module. The report can be filtered for a specific 
fiscal period or date range. The GL Distribution Report can display transactions for cash 
receipts, purchases, cash disbursements, adjustments, bank transactions, or any combination 
of these transaction types. 

Invoice Tracker 

Use the AP Invoice Tracker to review information about posted invoices. This includes 
information such as header and line item information, payment activity, and GL distribution 
of values for an invoice. 
The AP Invoice Tracker is loosely based on AP Invoice Entry and contains supplemental sheets 
not found in that program. 
User cannot add or update records in a tracker. 

Payment Tracker 

Use the Payment Tracker to display information about cheque records in the dashboard 
format. This includes information such as the cheque number, amount, and fiscal year and 
period in which it was posted. User cannot add or edit records in this tracker. 
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Supplier Tracker 

Use the Supplier Tracker to quickly display information about any supplier. This tracker 
displays information in the dashboard format and includes the invoice and payment activity 
to date and purchase orders (POs) for a supplier. 
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Imprest Management 
 

Imprest Setup 
Processing of Imprest requires pre-defined setup information as explained below. Most of the 
setup is one time setup except for the employee who will be created whenever there's a new 
employee that will require to process imprest. 

Staff Imprest Group 

Staff Imprest groups will be created in both supplier and customer groups. Supplier Group will 
be attached when you create an employee as a supplier for payment purpose and when you 
create staff as customer for processing invoice (receivable). 

Supplier Group 

Objective/Comment Supplier Group 
Requirement User must have access to Supplier  Group Entry form 

Navigation Path Financial Management  → Account  Payable  → Setup  → 
Supplier  Group 

Responsibility with Administrator 
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Screen/Form 
Usage: 

Supplier Group 

1. Click on the New Icon 

2. Type IMPR code in the Supplier group field 

3. Type description as Staff Imprest 

4. Save 

5. Exit the form 

Customer Group 

 

Objective/Comment Customer Group 
Requirement User must have access to Customer  Group Entry form 

Navigation Path Financial Management  - > Account  Receivable  - >Setup 
- > Customer  Group 

Responsibility with Administrator 

 
 

Screen/Form 
Usage: 

Customer Group 

1.  Click down from new icon and select New Customer Group 

2.  Type group code as IMPR 

3.  Type description as Staff Imprest 

4.  Save 

5.  Exit the form 
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Employee Setup (Customer) 

Employee for Imprest will be created as customer for the purpose o f  processing imprest 
invoices (receivables) that will be used to track outstanding imprest for retirement 
processes. 
 

Objective/Comment Customer Setup 
Requirement User must have access to Customer  Entry form 

Navigation Path Financial Management → Imprest Management 
→Setup → Imprest Customer 

Responsibility with Imprest Accountant 
Screen/Form 
Usage: 

Procedures 

1. Click down arrow from new icon and select New Customer type manually 
customer ID. 

2. Type the name of the employee on the Name field. 

2. Click down arrow on Type field and select Customer 
3. Tick on the box Imprest 
4. Navigate to Billing - > Detail and select Staff Imprest on the Group field 
5. Select Payment Method for employee 
6. Select Ship Via and FOB as per the default setups 

7. Navigate to Billing →  Credit →  Credit detail, then uncheck a tick on the 
box Credit 
Hold 8. Click on new and select New GL Control. Search and select already defined 
Type of AR Account and Control as ARIMPCODE 

9. Save and Exit the form 
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Employee Setup (Supplier) 

Employee for Imprest will be created as supplier for the purpose o f  processing imprest 
payment 
 

Objective/Comment Supplier Setup 

Requirement User must have access to Supplier  Entry form 

Navigation Path Financial Management → Imprest Management →Setup 
→Supplier 

Responsibility with Imprest Accountant 
1. Click down arrow from new icon and select New Supplier, enter the supplier 

ID and Name 

2. Tick on the box Imprest 
3. Go to Group field and select Staff Imprest 
4. Update the Terms, Ship Via, FOB and Payment Method accordingly 
5. On Imprest Customer field, click on the drop down and select the already 

defined Imprest Customer.  
NOTE: It is recommended for the Imprest Supplier ID and Imprest Customer 
ID to be the same. 
 
NITE: It is recommended the Imprest Customer and Imprest Supplier ID 
should be the same 

6. Click on New Icon and select New GL Control. 

8. Search and select the already defined Type of AP Account and Control of 
APIMPCODE 

9. Save and Exit the form 
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AR Terms 

AR Terms will be used for the calculation of  retirement d u e  date that will be based 
on the Imprest type selected e.g. Safari or Special imprest. Safari Imprest will be 7 
days retirement after returning b  a c  k  to the office and 2 days for special Imprest. 

 

Objective/Comment Terms Setup 
Requirement User must have access to Terms form 

Navigation Path Financial Management  → Account  Receivable  →Setup 
→ Terms 

Responsibility with Imprest Accountant 
1. Click down arrow from the new icon from standard tool bar and select New 

Terms ID 

2. Type 7Day or 14Days on the Code field 
3. Type Description as 7 Days  
4. On the Terms type select Days 
5. On the number of days field type 7 or 14 
6. Save and Exit the form 
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GL Control Code 

Objective/Comment GL Control Code 
Requirement User must have access to GL Control Code form 

Navigation Path Financial Management →General Ledger →Setup →GL 
Control Code 

Responsibility with Imprest Administrator 

 
AP Account 

1. On the down arrow of Type Select AP Account 
2. Select AP Account 

3. 
On the GL Control Code type APIMPCode and Type description as AP Imprest 
Control Code 

4. Save 

5. 
On the left side o f  the form, Expand t h e  + sign for GL control, AP 
Imprest Control Code, Account Context, and Main Book 

6. Select Expense and navigate to account button 
7. Click on the Account button, search and select Imprest Clearing Account 
8. From main book select Payables and navigate to account button 
9. Click on the Account button, search and select Imprest Control Account 

10. Save 
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AR Accountn 
1. Click on the down arrow of Type and Select AR Account 
2. Click on the New icon 

3. 
On the GL Control Code type ARIMPCode and Type description as AR Imprest 
Control Code 

4. Save 

5. 
On the left side o f  the form, Expand + sign for GL control, AP Imprest 
Control Code, Account Context, and Main Book 

6. Select Receivables and navigate to account button 

7. Click on the Account button, search and select Imprest Control Account 

8. From main book select Sales and navigate to account button 

9. Click on the Account button, search and select Imprest Clearing Account 

10. Save and Exit the form 

 

Imprest Type 

Imprest  type setup will be used to define imprest  types that will be attached with 
imprest GL control code for double entries and Terms that will be used to calculate  
imprest  due dates. Due dates will depend with the type o f  imprest selected. 
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Objective/Comment Imprest Type 

Requirement User   must   have   access   to   Imprest    GL   Control Management 
form 

Navigation Path Financial Management → Imprest Management →Setup → 
Imprest GL Control Management 

Responsibility with Imprest Administrator 
1. Click on the new icon and select New Imprest Type 

2. In the search field enter the imprest type code and its description e.g. 

Safari or Special imprest. 
 Click on Drop down Arrow and select the appropriate rule. 

 Exempt: System will allow user to get imprest even though has not 
retired. 

 Pending: System will allow only 1 imprest to employee until 
retirement 

 Due Date: System will allow another imprest to an employee as 
long as the due date of the original imprest is not over. 

3. Save 

4. Click on the new icon and select New GL Control 

5. On the description field type Description of the Imprest such as Safar 
Imprest 

6. Click on the GL Control type, search and select AP Account 

7. Click on the GL Control code, search and select APIMPCode 

8. Click on the down arrow of the Terms and select 14 Days 

9. Save 

10. Click on the new icon and select New GL Control 

11. On the description field type AR Account 

12. Click on the GL Control type, search and select AR Account 

13. Click on the GL Control code, search and select ARIMPCode 

14. Click on the down arrow of the Terms and select appropriate terms e.g. 7 
Days retirement for Safari imprest, 2 days retirement for Special imprest 

15. Save 

16. Exit the form 
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Imprest Process Flow 
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Imprest Issue 

All Imprest will be issued using Imprest issue form. This form is a journal entry form that 
will be using a memorandum Imprest book for commitment control purposes 

 
Objective/Comment Imprest Issue 

Requirement User must have access to Imprest Issue Entry form 

Navigation Path Financial   Management    →   Imprest   Management → 
General Operation → Imprest Issue Entry 

Responsibility with Accountant 

  
 

1. Click the down arrow  in the New button  on the Standard toolbar 
and select New Group. 

2. Group  ID will automatically be generated, you can change Apply 
date and Rate type if required to do so. 

3. Click the down arrow  in the New button  on the Standard toolbar 
and select New Imprest 

4. Type in Description of the Imprest to be issued 

5. Select Receiving date and Completion date accordingly. 
  NOTE: 
  Receiving Date: Date which the accountant receives the imprest 
Completion Date: Date which the employee will be returning 

6. Click   on  the  Supplier  Employee button   and  select employee who 
will be paid (supplier)  and customer who will be accounted for (make 
retirement) 

7. On the Comments field, enter in narrations of the Imprest 

8. Click the New button on the Standard toolbar and select New 
Imprest Line When  an  employee  has  an  outstanding   imprest, above  
message  will display  as  a  notification  but  it's  a  warning  user  should  
continue  to process/issue the imprest. Click OK to continue 

9. Select   an  Expense  Account  on the Debit field and SAVE 

10. You can append more lines as required, then Click Auto Balance button 
and then select GL Account (Imprest Clearing)account for double entry. 

11. Save 
12. Go to Actions from the tool bar and select Print Edit List to view 

the imprest information. 
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13. Click Submit for Approval box to submit the transaction for approval. 
Once the transaction is approved, the Approved box will have a tick. 

14. Go to Actions from the tool bar and select Post to post the imprest to GL. 
A second window will open in which user will submit this transaction by 
clicking on the Submit icon. 
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NOTE: 

1. Only Expense Account with sufficient Budget can be selected in the Debit field. 
2. if other currency is used  other than  base currency (TZS),  the amount  will  be converted  

to equivalent base currency based on the exchange rate determined, then commitment 
control will check  against  converted amount  (base amount)  but AP and AR invoices  will 
be processed  with the currency selected and the same currency will be used during 
retirement process. 

3. You can  select  more than  one line and each line will  be considered  with  sufficient budget 
by repeating step 9 

4. While Posting Imprest Issue using the IMPREST BOOK (memorandum Book, does not have 
effect on Main Book) system; 

6. Dr. Expense Account (Commits the fund) 
7. Cr. Imprest Clearing 

AP Invoice Generation 

Objective/Comment Generate AP Invoice 
Navigation Path Financial   Management    →   Accounts Payable  

→ General Operation → Invoice Entry 

Responsibility with Accountant 

1. System will automatic generates the AP Invoice entry in relating to 
Imprest. The invoice created will be done based on the scheduler 
which runs to create the group 

2. Click on the Group to search for the group created. 
Group created will be of the latest period and will gave the latest 
Group ID number. 
Group will be created with a user called Manager 

3. The selected Group  ID will display  all the AP Invoice 
information that will not require any data input. 

4. From the Header detail, tick  check  box Submit for Approval 
for the AP Invoice to be approved by responsible  person 

Approve Imprest AP Invoice 

Responsible officer will be able to login into the system and approve or disapprove  the 
transactions  awaiting  approval  and  as  well be able  to use  approval  tracker  to see more 
information of the  AP Invoices. 

 
Objective/Comment Post Imprest AP Invoice 
Requirement User must have access for Posting 

Navigation Path Financial   Management    →   Approval    Management 
→ General Operation → Approval Process 

Responsibility with Accountant 
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1. Approver will have the module buttons to approve whether to approve AP 
transactions or GL and PO transactions.  This access to approve will depend 
on the approval setup 

2. Select module that you want to approve i.e.  AP,  all  the transactions 
waiting to be approved will be displayed 

3. Go to Child tab and another tab of List and on the  box  Action to select  
transactions you  want  to approve,  and  then  go back to Detail tab and 
use the drop down arrow select  Approve to approve transaction. SAVE 
Approved transaction will disappear from the list. 

4. When  you  open again  AP  Invoice  entry  after  approved,  the approved 
box will be ticked  to show that  the transaction has been approved 

Post Imprest AP Invoice 

Objective/Comment Post Imprest AP Invoice 
Requirement User must have access for Posting 

Navigation Path Financial Management  → Accounts  Payable  → General 
Operation → Invoice Entry 

Responsibility with Accountant 
Screen/For 
m Usage: 

Post AP Invoice 

 
1. 

Click  on Action from the standard  tool bar, navigate to Group then 
select Post 

2. A dialog box will display f or  submitting the process. Click  on File 
then Submit 

3. Exit the form 

Note: 
While Posting AP Invoice in the MAIN BOOK System; 

Dr: Imprest Clearing A/C 
Cr: Imprest Control A/C 
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Payment Entry 

Objective/Comment Payment Entry 
Requirement User must have access for Payment Entry form 

Navigation Path Financial Management  → Accounts  Payable → General 
Operation → Payment Entry 

Responsibility with Accountant 
 

1. Click  on the  New Icon and  select  New Group, group  ID  will 
automatically be generated 

2. Click  down arrow  from the Bank Account  field and select Bank account 
that will be used for making payment 

3. Select Payment Method and Payment Date accordingly 

4. Click on the New Icon and select New payment 

5. Click  on the Supplier button,  search  and select  supplier  to be paid 

6. Click on the New Icon and select New Invoice payment 

7. Navigate to Invoice Detail tab 

8. Click  on the Invoice button, search  and select invoice that you want 
to make payment 

9. Save 

10. Navigate to Action from the standard  tool bar, then select Print group 
edit list to view accounting entries before posting 

11. Go to Payment Tab and submit the transaction for approval. Depending with 
the approval setups, once the transaction is approved it then can proceed for 
process payment stage. 

12. Navigate to Action from the standard  tool bar and select Process Payment 
to get an option for printing cheque 

13. Verify the cheque number to be printed 

14. Click on the Print icon from the standard  tool bar to print cheque 

15. Chose a correct printer for cheque, then Print 

16. Exit Print option sub form and process payment sub form 

17. Click to Actions menu bar and select Post. 
Submit  the process  of posting through  File -  >  Submit, from the 
standard  tool bar 
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Note: 
While Posting Payment Entry in MAIN BOOK, System; 

Dr: Imprest Control A/c 
Cr: Bank A/c 

Imprest AR Invoice Generation 

AR Invoice should be generated once Payment Entry has been posted so as to create 
receivable for tracking Imprest details including unretired Imprest 
 
Note:  

Generated AR Invoice will have the following GL transactions in MAIN BOOK; 
 
Dr: Imprest Control A/c 

Cr: Imprest Clearing A/c 
 

You  can  print  Aged Receivable  report  to see the outstanding Invoices 
Navigate to Accounts receivable   →   Reports   →   Aged Receivable 
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Imprest Retirement 

Imprest refers to amount of fund given to a staff where the amount of actual spend is not 
known and at the end of such activity a staff has to account for the amount that has been 
given. The amount given can be fully utilized or partially utilized or not used at all. Depend  on  
this  scenarios,  a  staff  imprest  will  be  retired  with supporting  attachment e.g. receipts  to 
show  the  actual  amount spent 

Full Expense Retirement 

This is the retirement whereby a staff has utilized the whole amount of Imprest given to 
perform a certain official activity 
 

Objective/Comment Expense Retirement 
Requirement User must have access for Expense Retirement  form 

Navigation Path Financial   Management → Imprest management  → 
General Operation → Expense Retirement 

Responsibility with Accountant 

Screen/For 
m Usage: 

Expense Retirement 

 

1. Click o n  the New Icon and select New Group, Group ID will 
automatically be generated. Change the Apply Date and Invoice Date 
accordingly. 

2. Click on the New Icon and select New Expense Retirement 

3. On the Retirement Summary tab, Select Receiving Date; a date o f  
receiving retirement  from the a staff 

4. Click  on the Select Imprest,  search  and select  Imprest  that you want 
to retire. Save 

5. Click on the New Icon and select New Expense line 

6. Click on the Imprest Line button, search and select Imprest Line that 
you want to retire. 

7. Enter the full amount expensed in Expense Amount field 

8. Save 

9. If there's  more than  one line you can keep on selecting new line, 
repeat step number 5 to 8 

10. You can Print Edit List through Actions → Group →  Edit list 

11. Click  on the Action from the standard  tool bar, and then select Group 
then Post to post to GL 
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12. Once the transaction has been posted, system will automatic generate the 
credit memo to offset the AR Invoice created. 

Note: 
While Posting Expense Retirement in MAIN BOOK, System; 

Dr: Expense A/c (Recognizing Expenditure) 
Cr: Imprest Control A/c 

Partial Expense Retirement 

This  is  the  retirement  whereby  a staff  has  utilized  some  of the amount  of Imprest  given 
and  has  to return  unspent  amount  in perform  a  certain   official  activity.  The  spent  
amount   will  be recognized  as  expenditure and  unspent  amount  will  be returned and 
captured  as cash receipt to the bank account. Partial expense retirement consists of two 
process i.e. cash receipt entry and credit memo/partial expense retirement as explained 
below; 
 

Objective/Comment Expense Retirement 
Requirement User must have access for Expense Retirement  form 

Navigation Path Financial   Management    →   Imprest    management → 
General Operations → Expense Retirement 

Responsibility with Accountant 

Screen/For 
m Usage: 

Expense Retirement 

1. Click o n  the New Icon and select New Group, Group ID will 
automatically be generated. Change the Apply Date and Invoice Date 
accordingly. 

2. Click on the New Icon and select New Expense Retirement. 

3. Select Receiving date; a date o f  receiving retirement  from the a staff 

4. Click on the Select Imprest, search and select Imprest that you want 
to retire 

5. Click on the New Icon and select New Expense line 

6. Click o n  the Imprest Line button, search a n d  select imprest line 
that you want to retire. 

7. Enter the amount expensed in Expense Amount field 

8. SAVE 

9. You can Print Edit List through Actions → Group →  Edit list 

10. Click  on the Actions from the standard  tool bar, and then select Group 
then Post to post to GL. 
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Note: 

While Posting Expense Retirement in MAIN BOOK, System; 
Dr: Expense A/c (Recognizing Expenditure) 

Cr: Imprest Control A/c 

Cash Retirement Entry 

Cash Retirement Entry is done for the unspent amount that staff is returning back to the 
office. 

Objective/Comment Cash Retirement Entry 
Requirement User must have access for Imprest AR Invoice Generation  form 
Navigation Path Financial Management → Imprest Management → General 

Operations → Cash Retirement 
Responsibility with Accountant 

 

Screen/For 
m Usage: 

Cash Retirement Entry 

1. 
Click  on the New Icon and select  New Group, group ID will 
automatically be generated 

2. Click  down arrow  on the Bank account  field and select Bank Account 

3. Payment Method will be updated as per the bank account setups 

4. Update the Payment Date accordingly. 

5. Click on the New Icon and select New Invoice Payment 

6. Type reference number on Check field 

7. Type the amount returned by staff in the Receipt Amount field. 

8. Type the Description on the Reference field. 

9. Click on the Customer ID  button, search and select the employee. 

10. 
Navigate to Invoice Selection tab and select invoice that have been created 
during AR Invoice generation. 

11. Click on Retrieve button if the transaction is not seen on the list. 
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12. 
After selecting  the Invoice, then click  on the Apply button  to apply 
invoice against cash receipt 

13. 

Go back to Header tab and click on the Expense Account field to select the 
expense account used to commit fund. By selecting the account, system 
returns the committed fund to the expense account. 

14. 
You can Print Edit List to see accounting double entries. 
To print the Edit List, click on the Actions in the menu bar and select Print 
Group Edit List.  

15. 
Navigate to Actions from the standard  tool bar and select Post to post 
transaction to GL 

Note: 
1. While Posting Cash Retirement in MAIN BOOK, System; 

Dr: Bank A/c (Recognizing Expenditure) 
Cr: Imprest Control A/c 

2. Follow the normal Expense Retirement procedures to proceed with remaining 
Expense amount 

Imprest Recovery from Salary 

 

Objective/Comment Salary Adjustment 

Requirement User must have access for Salary  Adjustment form 

Navigation Path Financial   Management    →   Imprest    Management → 
General Operation → Salary  adjustment 

Responsibility with Accountant 
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Screen/Form 
Usage: 

Salary Adjustment 

1. Click  on the Invoice button, search and select AR Invoice to be retired. 

2. Enter  the   negative   amount    recovered   from   salary    on Adjustment  
field  to  offset/clear  the  invoice  and  once  you entered amount, New 
balance field amount will change to zero if all amount o f  outstanding  
invoice. will be entered or display the balance o f  the remaining amount 
o f  invoice 

3. Click  on the  Imprest line button,  search  and select Imprest line to be retired. 

4. Type  the  description   of  the  transaction  on  the  field  for Description or if 
the descriptions  are too long then you can use a comment field. 

5. Save. Upon saving system automatic post the transaction. 

 

1. While Posting Salary Retirement in MAIN BOOK, System; 
Dr: Expenditure A/c (Returning the funds committed in Issue) 

Cr: Imprest Control A/c 
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Multicurrency Management 
 
The Currency Management module automates the process of conducting transactions 
internationally using multiple currencies. You can use this module to create multiple currency 
records. 
 

The Currency Management module automatically pairs each currency with the other 
currencies to create source and target currency relationships. Using rate types, you define the 
conversion rules for each currency pair. You can then enter and update exchange rates as 
often as necessary.  The application automatically applies these exchange rates against the 
international transactions generated in the current company. If necessary, rates can be 
overridden and locked for specific transactions. 
 

Application Setup 

Currency Master 

Use Currency Master Maintenance form to enter and update each currency for which your 
organization conducts business. You can create currencies for a specific company or global 
currencies for your entire organization. 
Each currency record defines the primary information needed to generate financial 
transactions with customers and suppliers in a specific country. A currency record contains 
the key details about the currency, such as its name, description, and currency symbol. This 
information is then leveraged by the Epicor application for any transaction conducted using 
this currency. 
 

A currency record can also contain the rounding rules it uses for various value types such as 
Unit Price, Unit Tax, and Extended Price. You can round these values up, down, and to the 
nearest value. You can also decide not to use a rounding rule against a specific value type. 
 

A GL control type and GL control can be assigned to each currency record. GL control types 
provide the template for the account and journal contexts used for transactions against the 
currency record; GL controls define the specific journals and accounts which record 
transactions in this currency. 
 

Objective/Comment Currency Definition 
Requirement User  must  have  access  to  Currency  Master  form  in  Currency 

Management 

Navigation Path Financial  Management  → Currency  Management →   Setup   
→ Currency Master 

Responsibility with As per the user matrix 

1 Click on the New Icon and select New Currency 

2 On the Currency Code enter the code of the Currency 

3 Define the Currency ID and Description 
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4 
Use Currency Symbol and Name to define further details of the 
currency 

5 SAVE 

6 
If the created Currency is foreign currency, click on the New icon 
and select New GL Control  

7 
Click on the Type to search and select the type of Currency 
Click on the Control to search and select already defined Gain/Loss 
account. 

 
 

NOTE: 
For Foreign Currency, the Inactive check box will be check, in order to remove it; 
exchange rate needs to be denied.  
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Rate Type Maintenance 

Rate types define the conversion rules the application applies against all the possible source 
and target currency pairs available within your company. Use Rate Type Maintenance to 
create and update rate types for currencies used by a specific company. 

 
Each rate type is a collection of overall default rate values and conversion rules. You first 
define the overall rate values for the group. For example, the Cross-Rate Currency and 
Alternative Cross-Rate Currency values define additional, interim currencies used by specific 
conversion rules in the group. 
 

Objective/Comment Rate Definition 

Requirement 
User  must  have  access  to  Currency  Master  form  in  Currency 
Management 

Navigation Path 
Financial  Management  → Currency  Management →   
Setup   → Rate Type 

Responsibility with As per the user matrix 

1 
Click on the Code to search and select the already defined Mean 
Rate  

2 
On the left side of the screen, expand and select the currency 
available 

3 
 For TZS-USD, on the Conversion Rule select Inverse 
USD- TZS will automatic become Direct  

4 SAVE 
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General Operations 

Exchange Rate Entry 

Use Exchange Rate Entry to define specific exchange rates for each currency pair. The Epicor 
application uses these rates to calculate converted amounts on international transactions. 

 
An exchange rate converts the value of one currency into an equivalent value in another 
currency. You enter exchange rates by creating an exchange rate record. You first select the 
rate type that will handle the exchange rates.  The rate type first defines the currency 
pairs, each of which consist of an original, or source, currency and a receiving, or target, 
currency. The rate type also defines the conversion rule (Direct, Cross-Rate, Double Cross-
Rate, and so on) used on each currency pair. 
 
You next define the Effective Date for the exchange rates. The application uses these 
starting from this date until the system clock reaches the Effective Date on the next 
exchange rate record. From this point, international transactions use the rates entered on 
the next record. 
 

Objective/Comment Currency management 
Requirement User  must  have  access  to  Exchange Rate  form  in  Currency 

Management 

Navigation Path Financial  Management  → Currency  Management → General 
Operation → Exchange Rate Entry 
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Responsibility with As per Matrix 

1. Click on the Rate Type to search and select already defined rate 

2. Click on the New icon to activate the form in which the date will 
read current date. Change the date accordingly 

3 On the Rate Value, enter the new current value. 

4. Save and exit the form 

 

 

Currency Revaluation Process 

Use the Currency Revaluation Process to adjust the amounts on selected records using 
current exchange rates for the dates you select. You can also use this program to generate 
the Currency Revaluation Report, which displays a preview of the revalued amounts. 
 
When you run this process or report, you can define which records you wish to revalue. 
You can select all or some AP invoices, AR invoices, bank accounts, or petty cash desks. The 
amounts are revalued based on the active exchange rate for the currency selected on each 
record. In any given reporting period, you would choose either the non- reversing revalue 
process or the reversing revalue process, but you can switch between either processes as 
you prefer. 
 
You can define the default modes o f  revaluation within Company Configuration and 
override these defaults, if needed, for a particular revaluation run (for example, a year end 
run). 
You also select which currencies to use during the revaluation process. You can run the 
process against one or multiple currencies. 
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Any gains and losses that occur from the revaluation are automatically posted to the 
accounts of each reporting currency. Each reporting currency has four accounts, the 
Realized Gain, Realized Loss, Unrealized Gain, and Unrealized Loss general ledger (GL) 
accounts. 
 

 
On Toolbar menu, Action Post and Print the Revaluation Report 

 

Cash Management 
 

The Cash Management Module contains functionality for creating and managing both Cash 
and Bank Accounts. 

 

Application Setup 
Cash Management include setup programs used to define bank accounts and bank fees 
associates with Cash Receipts, Cash payments, bank statements and bank adjustments. 

Bank Branch Code Maintenance 

Use Bank Branch Code Maintenance to enter and maintain a list of bank branch codes 
required. 

 

Objective/Comment To define Branch Code 

Requirement The user must have access to Bank Branch Code 
Maintenance in Cash Management. 

Navigation Path Financial Management → Cash Management→ Setup  → 
Bank/Branch Code 

Responsibility with As per User Matrix 
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Objective/Comment To define Branch Code 

 
 

 
 

Screen/Form Usage: Bank/Branch Code 
1.  Click the New Button on the standard toolbar. 

2.  Enter a unique identifier for the branch in the Code field. 

3.  In the Name field, enter the name of the branch. User select this 
name in the various programs. 

4.  In the Bank Name field, user can optionally enter the name of the 
bank that owns the bank branch office. 

5.  When user finish, click Save on the Standard toolbar. 

 

Bank Account Maintenance 

Bank Account Maintenance identifies bank accounts and defines their routing information, 
payment methods, and posting accounts. 
 
Use Bank Account Maintenance to define bank accounts and select the GL controls that 
determine the accounts and journal codes to which bank transactions post. 
 
NOTE: 

1. User must set up at least one bank account. If company has more than one bank 
account, user can define multiple account records to aid in the bank reconciliation 
process. 

2. A user account must be set up as a Security Manager in order to maintain bank 
accounts. Users that are not security managers cannot maintain these accounts 
and are restricted from accessing the setup option. 
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Objective/Comment To define Bank Account 

Requirement The user must have access to Bank Account Maintenance 
in Cash Management. 

Navigation Path Financial Management → Cash Management→ Setup  → 
Bank Account 

Responsibility with As per User Matrix 
1. Click on the New Icon and select New Bank Account. 
2. Enter the Bank ID, Bank Description and Bank Name respectively . 
3. On the Bank Identifier field, define the ID (it can be as bank ID). 
4. Search and select the already defined Bank branch using the Bank/Branch 

field. 
5. Update the IBAN Account Code and Checking Account as per the bank. 
6. Select the drop down for currency to select the Currency used for the bank 
7. Use the Cash Control check box to enable system to restrict users from 

using the bank account during payment if the account selected has 
insufficient fund. 

 
 
 

8. Save. 

9. 

Click on New button and select New GL Control 

 Click on the Type field and select Bank Account. 

 Click on the Control and search and select already defined the 
control account the bank. 

 SAVE 
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Objective/Comment To define Bank Account 

 

10. 

Click on New AP Payment Method and use the drop down arrow to attach 
the already defined payment methods for the bank. 

Note: The first method will be default. 

11. 

Click on New AR Payment Method and use the drop down arrow to attach 
the already defined payment methods for the bank. 

Note: The first method will be default. 
12. Save and close the form. 

 

Bank Fee Maintenance 

Bank Fee maintenance defines account results of bank fee. 
 

Objective/Comment To define Bank Fee Maintenance 

Requirement The user must have access to Bank Fee Maintenance in 
Cash Management. 

Navigation Path Financial Management → Cash Management→ Setup  → 
Bank Fee 

Responsibility with As per User Matrix 
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Screen/Form Usage: Bank Fee Code 
1. Click the New Button on the standard toolbar. 

2. Enter a unique identifier for the bank fee in the Code field. 

3. In the Description field, enter a description that helps users select 
this fee during transaction entry. 

4. When user finish Click Save on the Standard toolbar. 
The remaining fields are optional 

5. Click on the New GL Control and search and select the already 
defined Type and Account. 

6. Save and Exit the form 

 

General Operations  
This section describes the operations available in Cash Management Module. 

Bank Adjustment Entry 

Use Bank Adjustment Entry to adjust bank Account amounts and to enter bank fees. User can 
use Print Group Edit List on the action menu to review entries prior to posting. Use Post on 
the Action menu to post transactions in the selected adjustment group. 

 

Objective/Comment Entry of Bank Adjustments 

Requirement The user must have access to Bank Adjustment Entry in Cash 
Management. 

Navigation Path Financial Management → Cash Management → Operations  → 
Bank Adjustment Entry 

Responsibility with As per User Matrix 

1 
Click on New icon and select New Group from the standard tool 
button, system will automatic generate the group ID. 

2 
In the Default Transaction Date field, enter the date on which 
the adjustment occurs. 

3 
Click on the drop down arrow on Bank field and select the Bank 
Account. 

4. 
Use Reference and Description fields to define the details of 
the adjustment 
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Objective/Comment Entry of Bank Adjustments 

 
4 Click on New icon and select New Adjustment 

5 
Navigate to Adjustment tab 
Write the reference in the Reference field. 

6 
Enter the amount you are adjusting on the Amount field. 

If Amount is Positive, system will add the Cash Book 
If amount is Negative, system will reduce the cash book 

7. Save to get a Legal number 

8. 

Right click on the Account and search and select already 
defined account to be used. 
Or use Bank Fee option to search and select the already defined 
fee. 

9. Once Account is attached, save the form 

10. 
Click on Actions in the menu toolbar and select Post. 
A second window will open for posting, click on Submit icon to 
post or click on File then Submit. 

11. File Exit to close the form 

 
 

 



Ministry of Finance and Planning Tanzania - MoFP, 
IFMS –Impementation for GF Recipients,  
Epicor ERP 10.2 Training Manual, 
January, 2020. 

 

© Soft-Tech Consultants  Page 128 

Bank Funds Transfer (Within Implementer) 

Use Bank Transfer to transfer amounts between banks. The transfer creates journal posted 
to the accounts determined by the GL Controls assigned to the bank Accounts. The Journals 
typically debit and credit cash and transfer accounts for the bank account involved in the 
transfer. 
 

Objective/Comment For Bank Funds Transfer 

Requirement The user must have access to Bank Fund Transfer 
Maintenance in Cash Management. 

Navigation Path Financial Management → Cash Management→ General 
Operations  → Bank Funds Transfer 

Responsibility with As per User Matrix 

 
1. Click the New Button on the standard toolbar. 

2. In the Apply Date field, enter the date on which the transfer occurs. 

3. In the Transfer From section, select on the drop down arrow to select the bank 
account in which money is being transferred from. 

System will display the Current Balance of the bank 

4. In the Amount field, enter the amount to transfer in the currency of the account. 

5. In the Transfer to section, use the Bank field to select the bank which the funds 
are deposited. 

6.  In the Reference field. The application creates a default value that uses the short 
names of the two accounts. 

7.  When user finish, click Transfer field in which Legal number will be generated. 

8.  A window for posting will open. 
Click on the Submit icon or click on File then Submit 

9.  Once the transaction is submitted with status Process Submitted, File Exit to 
close and exit the form 

 

Intercompany Bank Funds Transfer (Across Implementers) 
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To be Added…. 
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Bank Reconciliation 

Bank Reconciliation Entry is used to reconcile bank statements with all the cash transactions 
created through Accounts Payable (AP) functions and Accounts Receivable (AR) cash receipts. 
Bank Reconciliation Entry only processes and clears cash transactions. 
To reconcile a bank statement, user select the receipts and payments that match bank 
statement lines. 
 
Use the Statement sheet to create the bank reconciliation and to identify the statement being 
reconciled. 
 

Objective/Comm
ent 

To create the reconciliation and transactions clearing 

Requirement The user must have access to Reconciliation entry form in Cash 
Management. 

Navigation Path Financial Management → Cash Management → General Operations 
→ Bank Statement Processing 

Responsibility 
with 

As per User Matrix 
 

 
1. In the Bank ID field, search and select code of the bank to be 

reconciled. When user complete this field, the application displays the 
bank’s currency, account and a reconciliation statement, if one exists. 

2. Click on New icon on the standard toolbar to create New Statement.  
Enter a concise description of the statement 

3. Use the Opening Date and Closing Date fields to enter the period 
included in the statement and  

4. Use the Closing and Opening Balance fields to record the bank 
balances on the two dates.  

System will allow user to enter the Opening Balance if it is the 
first time reconciliation 



Ministry of Finance and Planning Tanzania - MoFP, 
IFMS –Impementation for GF Recipients,  
Epicor ERP 10.2 Training Manual, 
January, 2020. 

 

© Soft-Tech Consultants  Page 131 

Objective/Comm
ent 

To create the reconciliation and transactions clearing 

If it is not the first time reconciliation, system will display the 
Opening Balance from the previous period’s closing balance. 

5. Change the Apply Date for the reconciliation. This value and the 
default fiscal calendar determine the entries displayed in the fiscal 
year fields. 

6. Save the form 

7.  Navigate to Statement Workbench tab 

8. On the clear Date field change the date accordingly (put end of the 
month) 

Click on the Retrieve button, system will give a window to 
select the date on which user can retrieve the transactions 
from the system. 

 
7. System will populate all transactions which have not been reconciled 

on the right side. 
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Objective/Comm
ent 

To create the reconciliation and transactions clearing 

8. To reconcile the transactions, User can double click on any transaction 
on the right column to indicate the transaction is reconciling with the 
statement as well or can click on any transaction and click on the 
Create Lines for system to reconcile the transaction. 
 

1. All reconciled transactions will be moved to the left side of the 
screen will have a Matched Status 

2. Proceed with all transactions which are seen in the bank 
statement. 

3. All cleared transactions will be on left side of the screen 
4. All Unpresented transactions will remain on the right side of 

the screen 
5.  If transactions have been cleared by mistake and it is on the 

left side of the screen, highlight the transaction and click delete 
icon in the standard bar. The deleted transaction will be 
returned to the right side. 

 
 Navigate back to Statement Header tab to confirm if the remaining 

amount in the Variance is the same as the total amount of Bank 
Charges or Bank Interests which are on the statements. 

Cleared 
Transactions 

Unpresented 
Transactions 
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Objective/Comm
ent 

To create the reconciliation and transactions clearing 

 
 Capture the Bank charges using the Bank Adjustment form in order to 

offset the variance. 
Once the charge/interest are captured, navigate back to Statement 
Workbench to search and clear the charge 

 Click on Actions button and select Print Edit List. 
Select which items the system should populate the data. 

 
 After exporting/printing the Edit List report. Click on the Actions icon 

and Post Statement 
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Procurement Process 
This part of the operational manual includes mandatory setups, managing suppliers, the 
creation and approval of purchase requisitions (PRs) and purchase orders (POs), working with 
purchase order suggestions, and monitoring the purchase order process using related reports 
and trackers. 
 

Application Setup  

Buyer 

Objective / Comments Creating buyer who is responsible for Purchasing, 

Navigation Path Material management → Purchase Management→ Setup →Buyer 

Responsibility As per User Matrix 

 
 

Screen/Form Usage: Buyer Maintenance 

A buyer is responsible for MoFP – GF purchasing activities. Buyer Maintenance is a key 
maintenance program, as it allows user to link a buyer to a part class and specify approved 
purchase amounts for buyers. A Buyer must first be defined as a system user, and then added 
as an authorized user for the Buyer ID. This will facilitate the Buyer to be able to process 
Purchase Orders. 
The Buyer ID is used as a search or filter field for PO Part Class purchasing. 

 

1.  Click on the new icon and Select New Buyer, Type the Buyer ID 
on the buyer field. 

2.  Type the buyer code and name on the person/contact field. 

3.  If the buyer has a specific PO limit type the limit amount on the 
PO Limit field. 
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Screen/Form Usage: Buyer Maintenance 

4.  

Click on the drop down arrow and select the Approval Person 
who is responsible to approve the PO and the buyer email 
address on approval person and email address field 
respectively. This information is optional. 

5.  Click Save and Exit Buyer maintenance form. 

6.  
Click on the new tab to select New Authorized Users. Click on 
the drop down and select the person in charge for procurement 
processes. 

 
 

Purchase Order Entry 

Objective/Comment Processing Purchase Orders 

Requirement User must have access to Purchase order entry form 

Navigation Path Material management → Purchase Management→ General 
Operations → Purchase Order entry 

Responsibility with Supplies  Officer 

 
 

Screen/Form 
Usage: 

Purchase order entry 

1.  Click New PO on the Standard tool bar. 
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Screen/Form 
Usage: 

Purchase order entry 

2.  On the Summary sheet, the PO Number default to 0. When the PO is first 
saved, the PO number is assigned automatically. 

3.  The Purchase Order Type default to standard. 

4.  The PO Date default to today’s date. User can change this date if user need. 

5.  Enter the Supplier ID in the supplier field, or click the Supplier button to 
initiate a search for the Supplier. 

6.  
Use the Header → Detail sheet to enter general order information when 
creating or changing an order. This sheet includes buyer, currency, due 
date, and payment term details. 

 
7.  Click Save on the Standard toolbar. 

8.  To Enter Purchase Order lines, 
Click the Down Arrow next to the New button. 

9.  Click New Line on the Standard tool bar. 

10.  On the option Buy for, select Inventory for stock items and Other for non 
stock items 

11.  

Select a part for stock items and Type any number/code on the Part/Rev 
field and its Description on the description field for non stock items. 
If the order is for stock item, click on the Part to select the Inventory item 
already defined in the system. System will automatic select and fill the 
name and description of the item selected. 

12.  In the Quantity/Cost section, select Our Quantity and type the Quantity 
and Unit Price that you are Purchasing. 
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Screen/Form 
Usage: 

Purchase order entry 

 

13.  

Click on Releases button on your left and expand the release tab then click 
release, this will take you to release tab. Click Get default to get the stock 
account if the PO is for inventory, or Expense Account if the PO is for non 
stock (other) 

 
14.  Save  

15.  Navigate to PO Summary button Untick PO ‘Hold’ then save 
PO 

16.  This PO will follow the same approval process. 
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Screen/Form 
Usage: 

Purchase order entry 

Navigate to header, submit for approval You will be asked if you’re sure to 
submit the PO because once it is submitted PO cannot be altered. Click OK 
is accepted and NO if rejected. 

17.  
System will produce another verification that the PO is successful 
submitted once it is saved. This PO will be approved by authorized person 
who is required to approve PO. After approval the PO can be printed. 

18.  

Printing Purchase Order;  

On the Approved Purchase Order Entry form, click on Actions  from  menu  
bar  then  select  Print  
Another window will display, then select Print Preview to review PO and 
you can Print to get the hard copy of PO. 

 
 

Receiving PO 

Receipt Entry consists of creating a header and line (s) to identify a purchase order receipt. 
The receipt header consists of a packing slip number, date, and other basic information, while 
the line consists of the quantity received against a purchase order line. 
 

Objective/Comment To record receipts of Goods/Services ordered 

Requirement The user must have access to Receipt  entry form 

Navigation Path Material Management→ Shipping/Receiving→ Receiving Entry 

Responsibility with As per Matrix 

 

Screen/Form 
Usage: 

Receiving  Entry 

1.  From the Menu Bar select  ‘New ‘record a new receipt. 
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Screen/Form 
Usage: 

Receiving  Entry 

2.  Click the PO button to select the Purchase Order  to be received. 

3.  In the Packing Slip field, type in the Packing slip/Delivery Note  number. 
Note that, this is a mandatory field and cannot be left blank. 

4.  Click on Save. System will automatic generate Legal Number 

 

5.  

From the Actions menu select Mass Receipts window. Selecting the Mass 
Receipts option will bring up all goods that have been ordered on the PO. 
User then select the goods/services that have been received. This is a more 
efficient option and thus recommended. 

6.  Identify and Select the Line(s) items to be received on the PO Releases 
section 

7.  All the lines which have been selected will go down on the Mass Receipts 
section. 

8.  Navigate to the right arrow to select the quantity if the PO received is less 
than ordered. Type in the Quantity which  is actually  received. 
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Screen/Form 
Usage: 

Receiving  Entry 

 
9.  If all quantities are all received, then Tick Get All and Receive 

All checkbox, (for all selected lines) then Process. 
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Screen/Form 
Usage: 

Receiving  Entry 

 
10.  In the Receipt is Compliant message, Click OK. 

11.  Print Good Receipt Note on Reports. 

 

Purchase Order Native Reports and Trackers 

Purchase Order Tracker 

Use Purchase Order Tracker to review information about purchase orders. 
This tracker is used to investigate open or closed purchase orders. 
 
Navigation Path 
Navigate to this program from the Main Menu: 
• Executive Analysis → Trackers → Purchase Order Tracker 
• Material Management → Purchase Management → General Operations → Purchase Order 

Tracker 
• Material Management → Shipping / Receiving → General Operations → Purchase Order 

Tracker 
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Inventory Management 
Application Setups 

Warehouse and Bin Maintenance 

Use Warehouse Maintenance to set up a warehouse. Inventory items are grouped in each 
warehouse. 
The inventory module need set up of at least one warehouse before user can enter any parts 
in Part Maintenance. 
In each warehouse there are multiple bins that can help user keep track of inventory within 
the same location. 
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Objective/Com

ment 

Warehouse Creation 

Requirement The user must have access to Material Management warehouse Setup 

form in Material management 

Navigation Path Material Management → Inventory Management  Setup → Warehouse 

Responsibility 

with 

As per User Matrix 

  

 

1  From the New menu, select New Warehouse 

2  Field Data type Warehouse code e.g. DAR 

3  In the description field type warehouse name and address 

4  Click save 

5  From the Actions menu, select Bins. 

6  Warehouse Bin Maintenance displays. 

7  Click New. 

Type Bin code e.g. MAIN 
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Objective/Com

ment 

Warehouse Creation 

Requirement The user must have access to Material Management warehouse Setup 

form in Material management 

Navigation Path Material Management → Inventory Management  Setup → Warehouse 

Responsibility 

with 

As per User Matrix 

  

 

 

8  In the Bin description field type bin name 

9  In the Type section, verify the Standard option is selected. 

10  Click Save. 
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Part/Inventory Items 

Use Part Maintenance to enter or update part information. Parts are either purchased items 
used for raw materials or subassemblies or manufactured items. 
Each part record contains crucial data user may need to purchase. It contains general 
information such as part number, description, and search criteria. A part record defines 
inventory information, which includes unit of measure (UOM) options for purchases, 
inventory, and non-stock classifications. Warehouse and bin information can also be defined 
for each part, including Minimum, Maximum, and Safety Stock quantities. 

 
 

Screen/ 

Form Usage: 

Part Creation 

1.  From the New menu, select New Part. 

2.  Enter code or part initial in the Part field 

3.  In the description field type the name of the part 

4.  Type select Purchased 

5.  On UOM Class drop down and select UOM class 

6.  Select Primary UOM e.g. Each (EA) 

7.  Tick quantity bearing item box. Save 
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Screen/ 

Form Usage: 

Part Creation 

Note The Quantity Bearing check box is selected by default for any 

newly entered parts. As a result, the Epicor application displays any 

found inventory for this part. If user clear the check box, the 

application ignores the part for all inventory transactions. 

8.  Navigate to the Part → Plants → Warehouses → Detail sheet. 

 

9.  From the New menu, select New Warehouse. 

10.  In the Warehouse field, select  Warehouse for the part created 

11.  In the Primary Bin field, select the primary Bin for the part 

12.  In the Minimum quantity of the inventory type the minimum 

quantity of the part 

13.  In the Maximum quantity of the inventory type the maximum 

quantity of the part 

14.  In the safety quantity of the inventory type the safety quantity of 

the part Save and close the form 
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General Operations 
 

All stores items will be purchased using normal MoFP – GF procedures of purchasing as 
covered in; Processing Purchase Order Entry processing. 

Issue of Materials 

The Materials can be issued to different department depending on the requisition/demand. 
This can be processed using the issue miscellaneous materials form in the material 
management. 

 

Objective/Comment To Issue Materials as per the department requisition 

Requirement The user must have access to issue miscellaneous material form 

in Material management 

Navigation Path Material Management → Inventory Management → General 

Operations → Issue miscellaneous materials 

Responsibility with As per User Matrix 
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Screen/Form 

Usage: 

To Issue Materials as per the department requisition 

1.  In the Part enter the part number user need. User can do this by entering 

the part number direct or by clicking search button to find and select the 

part. 

2.  Type the quantity user want to issue in the quantity field 

3.  Select reason code for the issue of items. This will define the offsetting 

general ledger account that will be affected 

4.  Select warehouse and bin from which user are issuing the materials. The 

Part display default warehouse and bin but this can be changed 

5.  Select the date of material issue in the date field. Save 

In the action button select Print icon to print material issue Report 

 
 

 

Post Inventory COS and WIP to General Ledger. 

 
The Epicor application does not calculate and post monetary amounts to the general ledger 
as soon as an inventory transaction is complete. Instead, these transactions are calculated 
(captured) and optionally posted to the general ledger when user run the COS/WIP Activity 
Run the Capture COS/WIP Activity periodically to optionally, post inventory and WIP activity 
to user general ledger. 
Important: To keep user COS and WIP values accurate, user should run this program at 
regular intervals. 
 
Material Management → Inventory Management → General Operations → Capture COS/WIP 
Activity 

1. Specify the date for posting material transaction to the general ledger 
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2. Tick Post general ledger box - This check box indicates that the captured WIP and COS 
information will update user General Ledger. This option is available if user select the 
Inventory check box on the General Ledger Configuration sheet. 

3. In the outdated transaction form allows for the capture of outdated transactions (from 
the date specified in this field) in the current period, and posts them with the first date 
of the period, as specified in the Outdate Trans Apply Date field. 

 
4. Then Click Submit 

 

 

Return of Items to Store 

 
There are occasions when materials requisitioned for certain works are in excess of what was 
actually required. Those items shall then be returned to stock by means of return 
miscellaneous parts to inventory. This process shall be given the same allocation code that 
was recorded in the Issue Note when the material was issued, so that the amount may be 
credited to the corresponding account. 

 

Objective/Comment Return Miscellaneous Material 

Requirement The user must have access to Return Material form in Material 

management 

Navigation Path Material Management → Inventory Management → General 

Operations→ Return Miscellaneous Material 

Responsibility with As per User Matrix 
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Screen/Form 

Usage: 

Return Miscellaneous Material 

      1 In the Part enter the part number user need. User can do this by entering 

the part number direct or by clicking search button to find and select the 

part. 

2 
Type the quantity user want to return in the quantity field 

3 Select reason code for the return items. This will define the offsetting 

general ledger account that will be affected 

4 The default warehouse and bin will be displayed this can be changed if 

needed. 

5 
Select the date of material return on the date field 

6 
Save and close the form 

Inventory Adjustments 

Use Quantity Adjustments to adjust the part master quantity on-hand. User can adjust the 

quantity either up or down. 

Quantity adjustment can be done only for parts that have the Quantity Bearing check box 

selected in Part Maintenance. 
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Important Adjustment transactions are generated to provide a full audit trail of all quantity 

changes made in this program. Select Transaction Log from the Actions menu to review 

adjustment transactions.  
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Objective/Comment Inventory Quantity Adjustments 

Requirement The user must have access to Quantity Adjustment form in 

Material management 

Navigation Path Material Management → Inventory Management → General 

Operations→ Quantity Adjustment 

Responsibility with As per User Matrix 

 

 

Screen/Form 

Usage: 

Inventory Quantity Adjustments 

1.  In the Part field, select the part /item user need to adjust. 

2.  In the Quantity field type the quantity to adjust e.g. -33 (negative). 

3.  A decreased quantity is entered as a negative number to adjust the 

current on-hand quantity. 

4.  In the Reason field drop down and select Count Adjustment. This will 

select the offsetting GL account control for the adjusted items in the 

inventory 

5.  Click the Adjust button. 

6.  Print material adjustment  report from the action print icon 

Exit Quantity Adjustment. 
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Inventory Physical Counting 

Initialize Physical Inventory 

 
Use Initialize Physical Inventory to initialize data and select parts (Inventory Items) in the 
specified warehouses in the current plant for a single physical inventory count. This is the first 
program user must run when performing a physical inventory count.  
After specifying the warehouses for which the program is being run, it performs the following 
tasks:  

1. Select all bins in the specified warehouse.  
2. Adds each part bin record to the cycle sequence.  
3. Flags the cycle sequence as a full physical inventory count.  

User cannot add, delete or move the parts assigned to the physical inventory cycle. The frozen 
pre-count quantities that result from running this program provide User Company with the 
ability to resume inventory transactions prior to completing the physical inventory program.  

When closing the physical count, the Epicor application uses this information for comparison 
to the physical count quantities entered into the Count Tag Entry program.  

Therefore, cycle count parameters must be defined at the part/warehouse, warehouse, 
part/plant, plant configuration and ABC code levels 
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Objective/Comment Initialize Physical Inventory 

Requirement The user must have access to Initialize Physical Inventory form 

in Material management 

Navigation Path Material Management → Inventory Management → General 

Operations→ Initialize Physical Inventory 

Responsibility with As per User Matrix 
 

1.  On the start date field select the appropriate count date 

2.  Select Include Zero QOH checkbox if user want to include inventory parts 

with zero quantity on hand 

3.  Select Include Non-Stock checkbox if user want to include non-stock items. 

4.  Navigate to Filter tab to select the Warehouse involved during physical 

count. 

5.  Click process icon to run the Initialize physical inventory 

6.  Exit the form 

 

Cycle Count Maintenance (Inventory Physical Count) 

 
Use Count Cycle Maintenance to perform key functional tasks for full physical inventories 

Objective/Comment Cycle Count Maintenance 

Requirement The user must have access to Cycle Count 

Maintenance form in Material management 

Navigation Path Material Management → Inventory 

Management → General Operations→ Cycle 

Count Maintenance 

Responsibility with As per User Matrix 
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 Select the specific warehouse in the warehouse field.  

Information in the fields such as Year, Cycle period, Cycle Number and 

Cycle date populates automatically reflecting the dates selected when 

Initialize physical Inventory. 

 Select the Full Physical checkbox.  

This indicates that the cycle sequence has been flagged as a full physical 

count by the Initialize Physical Inventory program. If the check box is 

selected, the cycle sequence is a full physical count. If cleared, the cycle 

sequence is flagged as a cycle count.  

Inventory parts populates automatically, cycle status field shows 

scheduled 

Navigate to the Actions icon 

 

Generate Tags 

 

Use Generate Cycle Count Tags to generate count or blank tag records for a specific cycle 

in a specified warehouse. It generates tag numbers for all parts that were previously 

assigned to a physical count using Initialize Physical Inventory.  

 

NOTE: User must generate tags before user can start the count sequence using the Start 

Count Sequence selection.  

Once count or blank tags are generated, the cycle status field shows Tags generated and 

user can use the Print Tags selection on the Count Cycle Maintenance Actions menu to 

print the tags being used in user actual physical inventory counts. 

 

Start Count Sequence 
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Use Start Count Sequence in preparation for actual counting of parts selected for a 

specified full physical inventory count in a selected warehouse.  

If a full physical inventory count is already in process for the specified warehouse, user 

cannot run Start Count Sequence; however, user can run it if there are other active cycle 

counts because each part can only be assigned to one cycle count sequence at any given 

time.  

Prior to running Start Count Sequence Count, user must first generate tag records for the 

selected   full physical inventory using the Generate Tags selection on the Count Cycle 

Maintenance Actions menu. However, Start Count Sequence can be run before printing 

count and blank tags using the Print Tags selection.  

Note: If possible, user should execute the Start Count Sequence process when there are 

no inventory adjustments taking place to avoid the likelihood of record locking issues.  

The Start Count Sequence selection performs the following functions:  

1. Freezes the unit costs for each part assigned to the selected full physical inventory, 

based on the costing method being used for the warehouse.  

2. Freezes pre-count perpetual inventory quantities in the full physical inventory  

3. Sets the Cycle Status to Count Started for the selected full physical inventory.  

4. Prevents inventory activity from taking place for the specified warehouse while a 

pre-count quantity snapshot is being created.  

5. For each tag number associated with the cycle sequence or full physical inventory, 

it verifies that each has an Open status. It skips tag numbers that do not have an 

Open status.  

Once user have started the count sequence for a selected full physical inventory, it can be 

reversed (using the Reverse Count Sequence selection on the Actions menu) as long as the 

Cycle Status has not progressed beyond Count Started (that is, no count quantities have 

been entered). The Reverse Start Count selection clears the snapshot quantity and cost 

values from the tag records and resets the Cycle Status back to Tags Generated.  
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Count Tag Entry 

 

Use Count Tag Entry to add or update the physical count information for count tags or 

sheets in a selected cycle sequence. Open tags can be updated, and blank tags can be 

added only until the cycle sequence has been posted using the Post Counts selection in 

the Count Cycle Maintenance Actions menu.  

 

 

1.  

Zoom the Cycle button, search for the particular inventory 

physical count cycle and select. The fields for warehouse, cycle 

period, year and cycle number will be populated automatically. 

2.  
Zoom the Tag button to select an individual/all inventory items 

to be filled with actual quantity from physical count. 

3.  
In the counted qty field fill in the quantity of from the actual 

inventory physical count. 

4.  
Type in the Counted by field the identifier number for the user 

who counted the inventory part. Save 



Ministry of Finance and Planning Tanzania - MoFP, 
IFMS –Impementation for GF Recipients,  
Epicor ERP 10.2 Training Manual, 
January, 2020. 

 

© Soft-Tech Consultants  Page 159 

5.  
Repeat step 4 to all other inventory items, use the navigation 

arrows to select the next inventory part. 

6.  Save and exit. 

Count Variance Report 

 Navigate to Actions icon > Count Variance Calculation/Report 

 

After entering actual quantity via Tag entry program from 

physical count, the Count variance report in the Actions icon 

become active, ready to be previewed/printed. 

 

Use this report to print the expected counts and the actual 

physical counts for each part counted, along with the values and 

variances.  

Values printed on the report are equal to the quantity times the 

current unit cost (average) from the Part Master file. 

Posting Inventory Counts 

Navigate to Actions icon, select Post Counts 
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Inventory Native Reports and Trackers 

List of Reports and Trackers 

1. Count Accuracy Report 
Use the Count Accuracy Report to view summarized count data by warehouse, by 
cycle period for a specified year. It allows analysis of how accurately inventory on 
hand counts have been performed in a specified warehouse.  

2. Inventory Usage Report 
Use this program to produce an Inventory Usage report to track inventory turns and 
monthly usage of stock.  

3. Inventory/WIP Reconciliation Report 
Use the Inventory/WIP Reconciliation Report to reconcile the General Ledger (GL) 
with costs from Inventory and work-in-process (WIP).  

4. Material Transaction Detail Report 
Use the Material Transaction Detail Report to produce an inventory transaction list 
created through receipt, issue, shipping, and adjustment processing.  

5. Parts Missing ABC Code Report 
Use the Parts Missing ABC Code Report to view parts in warehouses associated with 
specified plants that are missing an ABC code.  

6. Stock Status Report 
Use this program to produce a Stock Status report that contains a list of the current 
quantities and extended costs of all parts in Part Maintenance.  

7. Cycle Count Tracker 

Use the Cycle Count Tracker view all information related to scheduled cycle count or 
physical inventory count sequences. Many of the sheets available in the Cycle Count 
Tracker are read-only versions of sheets that appear in the Cycle Count Schedule 
Maintenance program.  

8. Part Tracker 

Use the Part Tracker to access current information on parts in the database. This 
includes information such as revisions, on-hand quantities, costs, and locations.  
User can use the Part Search feature to pull multiple part records into the Part Tracker. 
The tracker displays only one part at a time. User cannot add or edit records in this 
tracker.  
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Workshops 
 Issue Material and return  

 Return to stock 
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Asset Management 
 

This part describes the procedures to be followed when accounting for fixed assets. Fixed 
assets are those assets of value with a long life, which are not purchased for resale but are to 
be used in the generation of economic benefit to the Institute  for more than one year which 
are held by MoFP – GF 
At the date of acquisition, assets are recorded in the accounts at cost. However, an asset shall 
be considered “acquired” when it is placed in the position where it will be utilized and is 
ready” for service; therefore, all incidental costs incurred to place the asset in this status, are 
proper additions to the purchase price of the asset. 
 

Application Setups 

Asset Maintenance 

Use Asset Maintenance to enter and update records for fixed assets. Fixed assets can be 
organized in groups, class, and category. 

Objective/Comment To enter and update records for fixed assets (to add a new asset 
record) 

Requirement The user must have access to Asset Management 

Navigation Path Financial Management → Asset Management → Setup  → Asset 
Maintenance 

Responsibility with As per User Matrix 

 
Screen/Form 
Usage: 

Asset Maintenance 
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Objective/Comment To enter and update records for fixed assets (to add a new asset 
record) 

1.  From the New menu, select New Asset. Alternatively, in the Asset Number 
field, enter the asset ID and press Tab. In the New Confirmation message, 
click Yes. 

2.  In the Asset → Details sheet, enter the following required fields: 

 Asset Group – the asset group assigned to the asset or click Group 
to search in Asset Group Search; 

 The ID Number of an asset and 

 Asset description. 
Also enter the following additional fields 

 Acquired – the date the asset was acquired 

 Asset Class – the class assigned to the asset 

 Asset Cost – current cost value of the asset 

 Asset Number 

 Placed In Service – the date of service 

 Status – the current status of the asset 

 Tag – an alphanumeric field to keep an asset label 

Use the Register → Detail sheet to assign one or more registers to the asset. For MoFP – GF 
there is only one asset register for each business unit. 
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General Operations 

Asset Additions 

 

Objective/Comment To add an asset record 

Requirement The user must have access to Asset Management 

Navigation Path Financial Management → Asset Management → General 
Operations  → Asset Addition Entry 

Responsibility with As per User Matrix 

 
 

 
 

Screen/Form 
Usage: 

Asset Addition Entry 

1.  From the New menu, select New Addition. 

2.  Enter information in the detail fields that open the data entry. 

3.  When complete, click Save. 

4.  From the Actions menu, select Print → Print Asset Overview Report. The 
Asset Overview Report window will display, and then print the report to 
ensure that the record is accurately entered. 
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Screen/Form 
Usage: 

Asset Addition Entry 

 
 

 
 

 

Asset Addition Post 

Objective/Comment To post Asset cost to general ledger 

Requirement The user must have access to Asset Management 

Navigation Path 
Financial Management → Asset Management → General 
Operations  → Asset  Posting Process 

Responsibility with As per User Matrix 
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Screen/Form Usage: Asset cost Posting 

 
1.  Select the starting date and ending date to post the asset cost/asset 

addition. 
2.  In the Asset Activities tick Post addition. 

3.  In the Filter button user can filter the individual asset to be posted or 
individual group of asset to be posted. 

4.  Then click submit button. 

5.  Close the form 
Note: User Can use asset tracker report to view asset activity/transactions. 

 

Asset Depreciation 

All fixed assets have finite useful economic life, it is therefore necessary that MoFP – GF 
charges the cost of the fixed assets against income in respect of the use of such assets. This 
charge is referred to as depreciation. 
MoFP – GF policy is to depreciate its fixed assets using the Reducing Balance Method of 
depreciation.  
Use Asset Depreciation Calculation to calculate the depreciation of assets for the current year, 
current period, or for an asset's useful life. 
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Objective/Comment To Calculate Asset Depreciation 

Requirement The user must have access to Asset Management. 

Navigation Path Financial Management → Asset Management → General 
Operations  → Asset Depreciation Calculation 

Responsibility with As per User Matrix 

 
 

 
 
 
 

Screen/Form 
Usage: 

Asset Depreciation Calculation 

1.  In the Calculate Option field, verify Current period 

2.  Navigate to the Filter to select Individual Assets to depreciate. 

3.  Click Asset button and Search for asset. 

4.  Click Submit. 

5.  Exit Asset Depreciation Calculation. 

 

Asset Depreciation Post 

 

Objective/Comment To post depreciation cost to general ledger 

Requirement The user must have access to Asset Management 
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Objective/Comment To post depreciation cost to general ledger 

Navigation Path Financial Management → Asset Management → General 
Operations  → Asset  Posting Process 

Responsibility with As per User Matrix 

 

Screen/Form Usage: Asset depreciation Posting to update general 
ledger 

 
1.  Select the starting date and ending date to post the asset cost/asset 

addition. 
2.  In the Asset Activities tick Post depreciation. 

3.  In the Filter button user can filter the individual asset to be posted or 
individual group of asset to be posted. 

4.  Then click submit. 

5.  Close the form 
Note: User Can use asset tracker report to view asset activity/transactions 

 
 

Asset Disposal 

Use Asset Disposal Entry to record the asset disposal. This program is useful for recording new 
asset disposal activity as well as adjusting, deleting, and viewing unposted asset disposal 
activities. 
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Three disposal types are available in Epicor application i.e. Miscellaneous, transfer, and sale. 
Miscellaneous is a disposal that does not interface with another program, transfer - a disposal 
that interfaces with inventory and sale – a disposal that interface with Accounts payable. 
  



Ministry of Finance and Planning Tanzania - MoFP, 
IFMS –Impementation for GF Recipients,  
Epicor ERP 10.2 Training Manual, 
January, 2020. 

 

© Soft-Tech Consultants  Page 171 

 

Objective/Comment To dispose fixed asset 

Requirement The user must have access to Asset Management 

Navigation Path Financial Management → Asset Management → General 
Operations  → Asset Disposal Entry 

Responsibility with As per User Matrix 

 

 
 

Screen/Form 
Usage: 

Asset Disposal Entry 

6.  Use the Summary sheet select asset to be disposed. 

7.  Use the Detail sheet to enter disposal details including disposal type, cost, 
date, sale and transfer information. 

8.  Then click Ready To Post check box to post 

9.  Close the program. 

 

Asset Disposal Post 

Objective/Comment To post disposal cost to general ledger 

Requirement The user must have access to Asset Management 

Navigation Path Financial Management → Asset Management → General 
Operations  → Asset  Posting Process 

Responsibility with As per User Matrix 
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Screen/Form 
Usage: 

Asset Disposal Posting 

6.  Select the starting date and ending date to post the asset cost/asset 
addition. 

7.  In the Asset Activities tick Post disposal. 

8.  In the Filter button user can filter the individual asset to be posted or 
individual group of asset to be posted. 

9.  Then click submit. 

10.  Close the form 
Note: User Can use asset tracker report to view asset 
activity/transactions. 
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Year End Processing and Procedures 
 
This course is intended to help user understand important accounting items to review, 
execute, and report on prior to user Institute general ledger year end close.  
Notable prerequisites, activities, and housekeeping procedures are organized into two basic 
cycles. Each business cycle is thoroughly addressed and concludes with specific action items 
surrounding the GL. 
 
To help organize year end procedure suggestions, this course is organized into three main 
business cycles ; 
 
• Revenue Collection Cycle 
• Acquisition and Payment Cycle 
• Inventory Cycle 
 
Each business cycle is made up of a set of suggested prerequisites, activities, and procedures 
that when executed, can optimize entity’s year end close procedures. 
Every  period end procedures include action items unique to their business practices and 
operations. This course should be used as a starting point to assist user in developing 
procedures for User Company. 
 

Revenue Collection Cycle 
The Revenue Collection Cycle is made up of all processes which ultimately lead to  Institution 
total revenue intake. 
Because this is such an important cycle in an Entity's day-to-day business practices, several 
items must be reviewed before the fiscal year is marked as closed. 
 
In order to verify all credit memos, invoices, adjustments, and cash receipts for the 
current fiscal year were properly accounted for, use the following prerequisites, activities, 
and mandatory records in the order listed. 

Prerequisites 

 All  Miscellaneous Invoices have been recorded and posted. 

 All Credit Memos have been processed. 

 All Cash Receipts have been recorded and posted. 

 All Adjustments have been recorded. If they have not been recorded, execute any 
necessary write-offs. 

Activities 

 Process Customer Statements. 
This is an optional activity that is only meant to be completed if customers 
request year end statements. 
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 Reconcile Accounts Receivable accounts.  



Ministry of Finance and Planning Tanzania - MoFP, 
IFMS –Impementation for GF Recipients,  
Epicor ERP 10.2 Training Manual, 
January, 2020. 

 

© Soft-Tech Consultants  Page 175 

Aged Receivables Report 

This report serves as the subsidiary ledger to the Entity’s Receivables account. This report 
should be aged by Invoice Date.  
 
Furthermore, the date listed in the Aged As Of field should reflect the last date of the last 
fiscal period of the year user wish to close. The report total should reconcile to the ending 
balance of the Receivables account. If user find an out of balance condition, it may be 
beneficial to print an Aged Receivables Report for each individual period's date range. 
 

Acquisition and Payment Cycle 

The Acquisition and Payment Cycle is comprised of all procedures involved in the purchase 
and receipt of goods as well as cash disbursements to Institution’s suppliers. 

In order to verify all receipts, invoices, debit memos, adjustments and cash disbursements for 
the current fiscal year were properly accounted for, use the following prerequisites, activities 
and mandatory records in the order they are listed. 
 

Prerequisites 

For each period, verify the following:  

 All Receipts of goods have been recorded. 

 All Invoices received to date for receipts have been recorded and posted. 

 All Miscellaneous Invoices have been recorded and posted. 

 All Debit Memos have been processed. 

 All Disbursements have been recorded and posted. 

 All Manual Checks have been recorded and posted. 

 All Adjustments have been recorded. If they have not been recorded, execute any 
necessary write-offs. 

Activities 

• Reconcile AP Clearing account(s). 
• Reconcile Accounts Payable account(s). 
• Reconcile Bank Statement(s). 

 

Mandatory Records 

Generate these report(s) after user complete all prerequisite activity and before user enter 
any future period transactions. 
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Aged Payables Report 

This report serves as the subsidiary ledger to the Accounts Payable account. The Aged As Of 
date should reflect the last date of the last fiscal period. The report total on this listing should 
reconcile to the ending balance of the Payables account.  



Ministry of Finance and Planning Tanzania - MoFP, 
IFMS –Impementation for GF Recipients,  
Epicor ERP 10.2 Training Manual, 
January, 2020. 

 

© Soft-Tech Consultants  Page 177 

Received but not Invoiced Report 

This report serves as the subsidiary ledger to the AP Clearing account. The cut-off date should 
reflect the last date of the last fiscal period. The report total on this listing should reconcile to 
the ending balance of the AP Clearing account. 

Optional Records 

• GL Distribution Reports 
• Purchases 
• Cash Disbursements 
• Adjustments 
• Check Register 

 

Close the General Ledger 

Prerequisites 

• Verify all subsidiary ledgers have been generated and reconciled to corresponding accounts. 

Activities 

• Close all periods. When the last period is closed, the year is also closed. 

Records 

All reports in General Ledger can be generated on demand. The fiscal year and fiscal period 
control the data that is printed on these reports. 

• General Ledger Report  
• Trial Balance 
• GL Journal Listing(s) 

 
Close Period Entry Process, located in Epicor Help, is a great reference to use when closing a 
fiscal period or fiscal year. 

 
Year End Accounting Checklist 
 

A simple checklist of items is listed below. Consider the suggestions included on this checklist 
for each business user are working with to ensure user year end books are accurate. 
Once user have completed the items on this list, and before putting the books away for the 
year, run the financial statements by the owner or manager to identify anything of which user 
might not be aware. 
Finally, the last step of the year end process is to check user Revenue, Cost, and Expense 
accounts. Compare them to prior years to see if any increase or decrease is reasonable. If user 
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run across significant changes, user may want to look at the general ledger for that account 
to ensure the entries are legitimate.  
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Year End Checklist: 
 

 Are there any accounts receivables that are worthless and should be written off? 

 Is my balance in Allowance for Bad Debts a reasonable estimate of potential write-
offs? 

 Have we recorded all payables? 

 Does my general ledger bank balance reconcile to the bank statement? 

 Is the company's inventory balance correctly stated? 

 Are there inventory items that cost more than their worth and should be written 
down to their market value? 

 Have all assets been reviewed for accuracy? 

 Do the balances in the notes payable accounts (loans) agree with what the banks say 
we owe? 

 Are there other debts that have not been included on the books? 

 Are there debts on the books that no longer exist because of forgiveness or 
oversight? 

 Is my depreciation correctly recorded for fixed assets still in the company's 
possession? 

This item is only important if the Insitution has the Fixed Assets Module licensed. 
 
 


